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1 Introduction 

1.1 Welcome 

Welcome to Nesox Email Marketer Help! 

Nesox Email Marketer® is a professional email newsletter software and opt-in email 

marketing software for targeted mailing list building, email campaigns and bulk mailing. It 

also provides you with open and click tracking at your own computer. 

More than a bulk mailer or mass mailing software, Email Marketer is the perfect desktop 

solution for all your targeted email marketing needs and it covers every aspect of bulk email 

marketing. Email Marketer helps you create successful opt-in newsletters and email 

marketing campaigns. It is easy to build and manage your own opt-in mailing lists for 

subscribers, create and send email campaigns with personalized messages such as HTML 

newsletters, e-magazines, account statements, reports, statistics and bills to your customers 

in just minutes. You can also receive real-time opening and click-through tracking reports 

that help you measure ROI and refine your business strategy. 

At present, Email Marketer is being widely used in domains involved with direct email 

marketing, online marketing research, email newsletter, customer relationship management, 

permitted email marketing, direct mailing service, and collaborative working etc. Email 

Marketer has elicited great enthusiasm and customer appreciation from users all over the 

world. 

 

Best wishes for fun and success with Email Marketer! 

Getting started, create and launch my first email marketing campaign now! 

Homepage:  http://www.nesox.com 

Free support:  support@nesox.com 

Feature requests: feature@nesox.com 

Bug reports:  bug@nesox.com 

 

Nesox products are "Spyware", "Adware", and "Stealware" free! 

1.2 Overview 

What is Email Marketer? 

Nesox Email Marketer® is a professional email newsletter software and opt-in email 

marketing software for targeted mailing list building, email campaigns and bulk mailing. It 

http://www.nesox.com/
mailto:support@nesox.com
mailto:feature@nesox.com
mailto:bug@nesox.com
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also provides you with open and click tracking at your own computer. 

More than a bulk mailer or mass mailing software, Email Marketer is the perfect desktop 

solution for all your targeted email marketing needs and it covers every aspect of bulk email 

marketing. Email Marketer helps you create successful opt-in newsletters and email 

marketing campaigns, it is easy to build and manage your own opt-in mailing lists for 

subscribers, create and send email campaigns with personalized messages such as HTML 

newsletters, e-magazines, account statements, reports, statistics, bills to your customers in 

just minutes, and get real-time opening and click-through tracking reports that help you 

measure ROI and refine your business strategy. 

Who needs Email Marketer? 

With the increasing use of the Internet, email has become the marketing tool of choice for 

getting the message out to current and prospective customers and contacts. For most small 

businesses, permission-based email marketing campaigns are the most cost-effective way to 

reach new and existing customers. Email Marketer is the email marketing software of choice. 

Use it to quickly and easily create professional-looking email newsletters; targeting different 

customer segments with personalized messages. Most importantly, it brings value to your 

emailing campaigns. 

If you've wanted to use email marketing in your organization, or deliver email newsletters to 

your subscribers or customers, but you didn't want to use complex, confusing software or 

services that are too technical, Email Marketer is the perfect choice for you. 

Why Email Marketer? 

Electronic mail (e-mail) has always been an indispensable part of the internet, and probably 

the most used online web application, as well. It plays a very important role in today’s daily 

business transactions, personal life, and recreational activities. 

As such, e-mail service has become the most important service offered by most companies, 

and is regarded as a major indicator when it comes to judging one’s service quality. It is 

essential to the internet service provider and large corporations to come up with a complete 

e-mail service system; which will provide a proper solution to meet their scalability, delivers 

messages in time and reliably, and long lasting; a system that guarantees a smooth operation, 

and also ready to satisfy potential rapid increase in service demand. 

The flagship product of Nesox Solutions, Email Marketer™ is a corporate level mail delivery 

and tracking system which has proven to satisfy the needs mentioned above. It has already 

been adopted by every large ISP and major corporations, and is currently supporting millions 

of users. 

Different from some other e-mail systems employed by local intranet or small businesses, 

Email Marketer™ is specifically designed to provide the critical personalized group sending 

service for ISP and larger corporate customers, with emphasis on free scalability, excellent 
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performance, high reliability and practicality. During the years, Email Marketer™ has been 

upgraded constantly, improvements were made on various functions, and it has become the 

leading choice for email information service providers in today’s market. Email Marketer™ 

has a proven history of satisfactory performance for telecommunication usage, and with its 

scalability, it is now possible for ISP and corporations to establish an e-mail service platform 

to provide point-to-point mail delivery service for millions of users, at a low cost and also have 

a high service quality. All the features within Email Marketer™ will enable the customer to 

maintain a lower TCO (Total cost of ownership), improve the service quality, and therefore 

maximize profit. 

At present time, Email Marketer is being widely used in domains such as direct email 

marketing, online marketing research, email newsletter, customer relationship management, 

permitted email marketing, direct mailing service, and collaborative working etc. And, it is 

receiving customer appreciations from all over. 

Email Marketer™ is doing its utmost to support ISP and large corporate customers, in further 

reducing the TCO (Total Cost of Ownership), and setting up the core message service system. 

With its technical expertise in the internet services, dedication in the research and 

development of advance network and information technology, and vast experiences from 

previous projects, Nesox will be able to utilize the Email Marketer™ system to the fullest, and 

offer customers the best service possible in overall design and proposal implementation, and 

providing a full technological support. 

Nesox Email Marketer is amazingly easy to install, easy to configure and easy to use. Most 

users can send their first email campaign in few minutes, and sending subsequent campaigns 

takes mere seconds. Even if you have no technical background whatsoever, Email Marketer 

makes it simple to create email marketing campaigns for you. 

Personalized email marketing made easy with Email Marketer... Nothing compares. With 

Email Marketer you can easily: 

 Create eye-catching, colorful HTML messages with email templates and styles. 

 Compose your messages using the built-in WYSIWYG HTML editor. 

 Send personalized emails to your customers in minutes. 

 Pick targeted recipients based on subscribers' demographic information. 

 Track your email marketing campaigns in real time. 

 Build your own permission-based mailing lists. 

 Remove opt-out email addresses from your lists automatically. 

 Import or export contact lists from various data repositories: TXT, CSV, Excel, Access file 

and enterprise databases such as Microsoft SQL Server, Oracle etc. 

 Get opening and click results of your campaign real-time. 

 Keep customers coming back to your website and establish strong customer 
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relationships. 

 Proven technology based on years of R&D. 

 Your satisfaction is 100% guaranteed, you have a full 30 days to try the software 

risk-free. 

... And much more! 

Email Marketer helps you handle the enormous challenges you face: prepare the target 

mailing list, merge the personalized content, and distribute the contents in high speed. It 

makes your life easier and saves much your time for other aspects. 

1.3 Features 

Email Marketer makes building your business easy with tools that cover every aspect of email 

marketing via the following exciting features: 

1. Integrated environment with wizards 

 Unlimited Email Campaigns Management. Email Marketer has been designed to be 

completely adapted to project management. It lets you organize and save your work 

according to project milestones. 

 Step by Step Instructions. Provides a clear step by step approach to your projects by 

using distinct stages. A typical project is started at the design stage where you can 

create the message contents, scripts and distribution lists. After these tasks are 

completed, the project is published and in standby for review. 

 Simple, yet Powerful and Efficient. It is easy switch and manage between the 

accounts, message, script, list, preview, publish, report of a project. 

 Complex and Compact Interface. 

 Multi Languages. Just one click to switch the interface to your own language, even the 

campaign reports. 

2. The appealing layouts for rich message contents 

 WYSIWYG Editing. Includes a professional HTML editor similar to popular web editors, 

with WYSIWYG, source and preview modes. If you would rather use your preferred 

application, Email Marketer is fully compatible with all content creation applications such 

as DreamWeaver, FrontPage etc. 

 Rich Templates. When tight deadlines dictate your success and the need for immediate 

content arises, Email Marketer utilizes your pre-existing templates such as newsletters, 

email ads, stock quotes, push-email, etc. 

 Message with both HTML and Text. Email Marketer makes the creation of contents 
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easy by offering you the possibility to create an alternate text via HTML message. 

 Embedded Media in HTML. Email Marketer can embed media such as graphics, sound, 

flash in HTML to send them along with the message, rather than having them reside on 

a web server somewhere. 

 Visual Personalization. Similar to Active Server Page (ASP) scripting language, these 

embedded scripts let you customize your contents without any limit. And, the text and 

script editors with colorize, indent, bookmarks and debugging features for your scripts. 

 Importing and Exporting. Save and load your original work or an online web page in 

clicks. 

3. Always use highly-focused and updated mailing 

lists 

 Integrates with Any Database on the Network. Connecting to Excel, Access, SQL 

Server, Sybase, Oracle, MySQL, XML and other ADO and ODBC/OLEDB compliant 

databases and automatically generating necessary SQL queries. 

 Direct Data Source Connecting. Avoid unnecessary duplication by connecting directly 

to the database related to the project. You save time and you work directly on the most 

accurate and up to date data. 

 Predefining Lists. Predefining data sources and SQL queries (segments) for quick and 

easy user access. 

 Built-in List Database with a Capacity of Millions. Email Marketer lets you 

alternatively create a project-specific database with your preferred application. 

 Validating Your List. Email Marketer makes the elaboration of receivers list easy 

thanks to a full set of tools: removing of duplicates, management of fields containing 

several email addresses, sending of test message and checking of address validity. 

 Excluding with Black Lists. All these features are also available for the creation and 

the management of black lists. It allows you to exclude receivers without modifying the 

data source. 

 SQL Queries. Email Marketer supports SQL queries to let you quickly create distribution 

lists from outside database records (data source) for those who want a more advanced 

interface to the database. You can also import most database formats found on corporate, 

office or personal systems. 

 Importing and Exporting. You can also import or export with most database formats 

found on corporate, office or personal systems in clicks. 
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4. Unlimited personalization of your messages 

 Fields Merge. Insert database fields in the message body or in the subject. You can 

customize your contents by using an unlimited number of data source fields. 

 Dynamic Contents. Enable contents according to your conditions: Email Marketer 

allows you to modify contents before the delivery. Via personalization script, you can 

easily decide who will receive which contents according to receiver's country, preferred 

products, purchasing date, etc. 

 Advanced Personalization via Message Scripting. By using the script interface, 

Email Marketer allows the generation of emails with a much higher level of customization 

than only database field merging: management of sendings according to time zones, 

personalization of attachments for each receiver, etc. The only limit of personalization is 

your data source precision. 

 VBScript Compatible. Users familiar with VBScript or Active Server Pages can directly 

edit the mailing project global script to further customize the mailing project. Samples of 

global scripts are provided and available to users not familiar with VBScript. Script 

commands can include any VBScript function. 

 Message Preview. Program enables you to view each personalized message before 

they're sent. 

5. Control delivery, measure efficiency 

 Selective Format. Send specific content for each receiver in Text or HTML format. 

 SMTP Free Delivery. Emails may be delivered directly or relayed to multiple SMTP relay 

servers for large scale distribution. Built-in email delivery server that frees you from 

email limits placed by your ISP. 

 Secured Messages. Via the S/MIME protocol, Email Marketer gives you the opportunity 

to send secured messages. Emails are digitally signed and their contents encrypted. It 

guarantees your messages origin, integrity and confidentiality. This tool will open new 

doors for email use (commercial data, billing, banking information, intern or extern 

communication of confidential data...). 

 Schedule your mailings. Allows automatic scheduling of email campaigns for 

launching on a daily, weekly, or monthly basis etc. Email Marketer Scheduler Service 

manages this difficult job for you. 

 Speed Adjustment. Email Marketer can slow or accelerate your email campaign 

sending speeds in accordance with your mail server maximum speed, or to match your 

ISP bandwidth or other Internet access limitations. Outbound email campaigns are easily 

throttled by messages per hour and help keep you compliant with your service provider. 

 Fast, Multi-Threaded Sending. On a fast PC, Marketer can saturate a T1 line with 
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outbound email, using up to 512 threads for message generation and delivery. 

Depending on your database speed, CPU, and complexity of your scripting, Marketer can 

generate up to 30 personalized messages per second. Many ISPs throttle back the 

amount of email you may send. If that is too much for your mail server to handle, 

Marketer lets you specify how many messages to send per unit time for precise flow 

control. You can scale it back to 100 per hour if necessary. 

 Delivery Testing. Send test emails to yourself before launching the entire campaign 

and decides the next. 

 Continuous Retry. For failure deliveries, Email Marketer attempts to resend them 

automatically. Retry count could be customized. 

 Delivery Resuming. Resumes sending from the previous breakpoint it left off and no 

duplicate mails are sent. 

6. Handles subscription and unsubscription real time 

 Subscribe by Email or Web Form. If you have a website, Email Marketer helps 

subscription via web form. If not, incoming messages with special topic also does the job. 

Manage efficiently: add new data or update your database, automate the sending of new 

emails, manage easily the opt-in and opt-out processes or route emails automatically 

when receiving web forms. 

 Unsubscribe Link in Message. Email campaigns can be sent with a working 

unsubscribe link automatically inserted in the message, making accurate unsubscribe 

processing a breeze! The software automatically flags recipient addresses which have 

unsubscribed, no matter what list they are on. 

 Incoming Messages Management. If you are using an off-line list database, Email 

Marketer handles and converts opt-in or opt-out requests received via web forms to 

requests with email to your mailbox. 

7. Website Integration with subscriber and tracking 

service 

 Multi List Subscription. Email Marketer works with customizable subscriber, our 

revolutionary web-based subscription management. 

 Customizable Subscription Form. Your customers can set their own email 

preferences, select options or indicate interests directly from your website. This data is 

directly available to Marketer, making targeted communication with your customers a 

snap. 

 Tracking for Open and Click. With email tracking service, every e-mail that you send 

is invisibly tracked. You will be advised when, exactly, your email was opened and which 
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hyperlink was clicked without alerting the recipient. 

 XML Based. Both the online subscriber and tracking results are XML based and 

communicated with Email Marketer. 

8. Professional and real-time reports 

 Rich Campaign Reports. HTML formatted and consists of tables, graphs and charts to 

represent opening rate, click rate, statistics per receiver or per day, etc. Your 

organization is able to analyze your receivers' behavior, to measure the campaign 

efficiency, to evaluate its impact on sales, etc. 

 Rich List Reports. List reports tell you the scale of your mailing list and groups, 

subscriber and unsubscriber amount by date with charts. 

1.4 Editions 

Editions Overview 

We provide two editions of Nesox Email Marketer: Personal Edition and Business Edition. 

Personal Edition 

 Create and manage unlimited mailing list database 

 Rich list reports 

 Create, design and deliver mailing campaign projects 

 Rich campaign project reports 

Business Edition 

 All features of Personal Edition 

 Scheduling message deliveries 

 List subscribe or unsubscribe via email or web form 

 Possible to manage online list database and accept subscribe/unsubscribe via listing 

service 

 Possible to track email opens and clicks via tracking service 

You can download the trial version of each edition of Email Marketer and try it for free before 

purchasing. So, you will get a good feel about how the software works and how you can 

benefit from it. The Trial Edition may be converted into a full (registered) edition by entering 

a valid registration key. 

http://service.nesox.com/
http://service.nesox.com/
http://service.nesox.com/
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Edition Differences 

To see which edition of Email Marketer is best suited to your needs please check out all of the 

features, which goes through the differences in depth. 

Function / Edition 
Personal 

Edition 

Business 

Edition 

Mailing List 

Build-in List Database with a Capacity of Mega   

List Validation, Querying and Grouping   

Various List Data Source Linking   

Various List Data Repositories Linking   

List Attribute Field Customization   

List Importing and Exporting with Various Format   

Subscribe or Unsubscribe via Email   

Subscribe or Unsubscribe via Static Web Forms      

Customizing for Subscribe and Unsubscribe Form   

List Statistics Reports   

Campaign Project 

Project Management   

Project Protective Encryption and Compression   

Project Statistics Reports   

Email Design 

Rich Content Templates   

Rich Style Templates   
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WYSIWYG HTML Editing   

Embedded Media in HTML   

Importing and Exporting   

Personalization   

Spelling Check   

Email Delivery 

Multi Mail Account Management   

SMTP Free Delivery   

Concurrent Multi-Thread Delivery   

Mixed Delivery   

Message Preview before Delivery   

Delivery Testing   

Delivery Logs and Diagnosing   

Delivery Retry for Failures   

Scheduling Deliveries   

Others 

Multi Language Support and Switch   

Automatic Upgrade Checking   

Real-time Tracking for Bounce Back Messages   

Real-time Tracking for Message Read  * 

Real-time Tracking for Message Click  * 



Nesox Email Marketer User’s Manual 

 

Copyright © 2010, Nesox Solutions. 20 

* Works by renting or hosting the Email Tracking Service. 

1.5 System Requirements 

Hardware requirements 

1. Pentium 133 or above 

2. True-Color Displayer (800x600 16bit) 

3. 32MB RAM or above 

4. Hard disk drive with at least 20 MB free disk space 

5. Mouse 

6. Internet Connection 

Software requirements 

1. Windows 98/ME/NT/XP/2000/2003/Vista/7 

2. Internet Explorer 5.5 or later 

 

Windows95, Windows98, ME, XP, Windows NT, Windows 2000, Windows 2003, Windows 

Vista, Windows 7, Outlook, Outlook Express, Internet Explorer are registered trademarks of 

Microsoft Corp. 

Palm Desktop is a registered trademark of 3Com Corporation. 

All other trademarks are owned by their respective companies. 

2 Installing and Uninstalling 

2.1 Installing 

If you are installing from the Internet 

You may download the Email Marketer software from the following link: 

http://www.nesox.com/en/email_marketer_downloads.asp 

1. To download Email Marketer installation to your computer, simply click the Save button 

and save the installation file to your computer. Be sure to remember where you saved the 

file (the desktop might be a good place). 

http://service.nesox.com/
http://www.nesox.com/en/email_marketer_downloads.asp
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2. Once the file has downloaded completely, open the folder containing the file you 

downloaded. 

3. Double-click the installation file Marketer_Business.exe you just downloaded to start 

installing Email Marketer on your computer. 

You may wish to visit our website http://www.nesox.com to ensure that you always have the 

latest version of Email Marketer. 

If you are installing from the CD-ROM 

1. Insert the CD into your CD-ROM drive.  

2. If the installation does not auto-start, double-click Marketer_Business.exe from the 

CD.  

Installation Wizard 

Please make sure you are logged on to your computer either using the administrator account 

or that your account has administrator rights to install software. Follow the easy instructions 

that will guide you through the rest of the process. You may cancel the installation at any time 

by clicking Cancel. Please note if you are upgrading from the previous version of Email 

Marketer, you do not have to uninstall your current installation. 

1. First you will see the welcome screen. Click the Next button. 

2. The Wizard will display the End-User Licensing Agreement (EULA). Read the entire 

agreement and use the scroll bar to move through the text. If you agree with the terms 

of the EULA click I Agree. 

3. The Wizard will ask you the folder location where Email Marketer will be installed (By 

default, the location is C:\Program Files\Email Marketer Business Edition\). If you need 

http://www.nesox.com/
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to install Email Marketer to a particular location, click the Browse button and select the 

path of the Email Marketer installation folder and click OK. Otherwise, click Next. If you 

are upgrading from the previous version of Email Marketer, please ensure the path is the 

same as used previously. 

4. Choose the program manager group of the start menu. Default is fine. Click Next. 

5. You will see a message window telling you that your installation is complete. Click 

Finish. 

6. Email Marketer is now installed. Click Start on the taskbar. On the Start Menu, move 

your mouse pointer to Programs. On the Programs menu, you will see the Email 

Marketer Program Group icon. You may click Email Marketer Administrator to launch 

the application now. 

 

During the installation process, you may receive a warning about a running instance of Email 

Marketer. If this occurs, close the Email Marketer Administrator and Email Marketer Monitor 

(at the taskbar's tray area) and then continue the installation. 

Note: If your operating system is Microsoft Windows 98, to install and use Email Marketer, 

you should have MDAC (Microsoft Data Access Components) and Microsoft JET 4.0 driver 

installed on your system. You can also download them from the Email Marketer download 

center. When using Windows ME/NT/XP/2000/2003/Vista you don't need to install anything. 

As all required drivers are already installed. 

* For Email Marketer Personal Edition, the installation package is Marketer_Personal.exe. 

* For Email Marketer Business Edition, the installation package is Marketer_Business.exe. 
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2.2 Uninstalling 

To uninstall Email Marketer from your computer, you will need to shutdown all Email Marketer 

program instances and follow one of the following two ways to uninstall Email Marketer: 

Go to Start -> Programs -> Email Marketer Business Edition -> Uninstall Email 

Marketer Business Edition and follow the guides 

or 

Go to Start -> Settings -> Control Panel. In the Control Panel window, double click 

Add/Remove Programs. Find and select Email Marketer Business Edition, click Modify 

/ Remove and follow the guide. 

Note: It is strongly recommended that you backup your project files before uninstalling the 

program. 

3 Getting Started 

3.1 Getting Started 

Launching Email Marketer is straightforward. During the installation process, the installation 

program created shortcuts to launch Email Marketer directly from your desktop. Once 

installed you can start Email Marketer by going to Start -> Programs -> Email Marketer 

Business Edition -> Email Marketer Administrator. 

It is strongly recommended that you read the Knowledge Base before your creating the first 

project. 

Going through this very short tutorial will quickly familiarize you with the features of Email 

Marketer, and get ready to create and launch your own email campaigns. You will also pick up 

some neat ideas you can use later for planning your own campaigns. Now, we are going to 

walk you through every step to sending your first test mailing. Message tracking and 

subscribe or unsubscribe are not included in this section of the user manual, but will be 

discussed later individually. There are just 8 steps, from setting up, through defining and 

entering your data, to sending! 

Before You Begin - Create Your Mail Accounts 

Mail on the internet is delivered through what is called an "SMTP server". Before you start 

using a mass email program like Email Marketer, you should decide who (or which server) will 

deliver your e-mail after you send it. We recommend using a dedicated SMTP server. Email 

Marketer has its own build-in SMTP server, but in some cases where using any internal server 

on your machine to send directly will not work. 

To create an account, click Mailing Accounts located on the left pane, click New to start an 
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account wizard and enter the properties of your account. Please make ensure to verify the 

settings by clicking Verify button before the saving. You will need the same SMTP Server 

settings and information as needed to set up a Microsoft Outlook or Outlook Express account.  

If you do not know this information, you may want to go research it with your system 

administrator or web service provider before getting started. Of course, you may create more 

accounts according to your needs. 

It is important to note that your Internet Service Provider may have restrictions on how much 

email they will allow you to send through them. What's more, many ISP SMTP servers are 

badly overloaded. If you own a website, setting up your mailing accounts using your 

web-hosts SMTP server facilities is almost always your best choice. 

If you are a Business Edition user, you may also specify your tracking service account here. 

Start Your First Email Marketer Project 

The following 8 steps will guide you to create and launch a simple email campaign using the 

build-in list database with personalized messages. This getting started manual gives you a 

brief overview of the Email Marketer features, benefits and some related concepts. The 

purpose of this section is to get your list up and running as quickly as possible. If these 

instructions are not clear, you can always learn from other topics in this manual with Email 

Marketer Projects for more detailed information. 

Step 1 –Creating and Managing Mailing Lists 

Click Mailing Lists on the left pane. 

Click the New Contact button located on the bottom left side of the screen. Enter your 

Display Name (this could be your full name), First Name and Email and click OK. Repeat New 

Contact additions with as many as your other email addresses as your wish. It's a good idea 

to use valid email addresses so that you can see what your mail looks like after the testing. 

Step 2 –Creating Marketing Campaigns 

Click New Project on the upper left pane. The program will guide you to the General view of 

the created project. Please acquaint yourself with the interface of this screen as we will be 

using it for the remaining steps toward composing your email. Across the top you will find six 

tabs. You are placed in the General tab by default when opening this screen. Notice the: 

Message, Scripts, Publishing and Reports tabs. 

On the General tab, enter the Title and Description (for example: "My First Project"). Email 

Marketer also provides a Project Wizard feature which provides you with step by step guides 

that will enhance your project creation. You may choose to use this function or choose default 

and create your own message. 

Step 3 – Composing Email Messages 

Switch to the Message view by clicking the Message tab located along the top of the screen. 
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The From field and Reply To field will be selected automatically with your default mailing 

account. If you have entered multiple accounts you may click on the drop down menu to 

choose which account you would like to send from. 

Enter the Subject (for example: "<%=[FirstName]%>, how are you doing?"). By doing this, 

the <%=[FirstName]%> command will act as a block of Personalization Script which instructs 

Email Marketer to insert the First Name of each recipient on your list of contacts in the subject 

line of each email. This personalized script is then followed by your greeting ”How are you 

doing?”. 

Now enter some text in the message body. You may enter scripts in the message body as well. 

You may enter these scripts manually or click Insert > Contact Attribute Script and select 

one of the listed attributes, Email Marketer will generate and insert the script automatically. 

If the message is not written in any European languages, you may click on Advanced, 

Tracking Settings button and select your preferred language for the message character 

encoding. 

After composing, we recommend that you click on the menu Message > Check Spelling and 

Message > Check Script Syntax to ensure the message contents are correct. 

If you are a Business Edition user, you may also specify the tracking server and account by 

clicking the Advanced, Tracking Settings button to enable the tracking of email opens and 

click-throughs. 

Step 4 - Message Personalization (Optional) 

Switch to the Scripts view by clicking the Scripts tab along the top of the screen. 

Type the following text to the script editor: 

Message.Html.Text = Message.Html.Text & "<br>Created at " & Now 

Step 5 – Choosing Recipients 

Switch to the Recipients view by clicking the Recipients tab along the top of the screen. 

Select "Marketer List Database" to fill the To Mailing List field and select "All List Contacts" 

as the To List Group field. 

List details of 3 sample contacts also with you entered at the first step will be displayed. 

Select one of the contacts and click the Preview Message button to preview what the 

personalized message you are about to send will look like in their inbox. 

Step 6 - Delivery Performance Adjustment (Optional) 

Switch to the Publish view by clicking the Publish tab along the top of the screen. 

Click the Options and Performances button toward the upper right hand side of the screen. 

If you are on a cable modem or consumer service provider, you may want to set the number 

of threads to 1 (default is Automatic) since your provider may restrict the number of mail 

connections made at once. You may specify the delivery mode to Direct/Mixed Mailing 
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from Relay Mailing to enable the built-in SMTP engine. 

Click OK to close the preference dialog. 

Step 7 - Message Delivery 

Create a publish task by clicking the New Task button located toward the upper center of the 

screen. This tells Email Marketer you are ready to send the email you have composed to the 

recipients you choosed. 

Click the Test button on the bottom and enter your own email address to see what the email 

will look like in your inbox. You may also enter any of the other addresses in your contacts list. 

To preview what it will look like in their inbox as well. You can also click Send This Message 

button in the preview window to start a test delivery. If you are satisfied with delivery result 

and the way the email looks in the preview, you are ready to send the campaign! 

Click the Start button and you will be prompted to save the project. Click Yes to save and 

watch them go! 

When all of the messages are sent, you will be able to see how many successes and how many 

failed deliveries there were. Note: You should review this information and remove any 

non-functioning email addresses from the mailing list as they will only slow down your 

sending in the future needlessly. 

Step 8 – Campaign Reports 

Switch to the Reports view by clicking the Reports tab along the top of the screen. 

Click the Refresh button to create reports with live results. 

Conclusion 

This getting started manual gives you a brief overview of the Email Marketer features, 

benefits and some related concepts. The purpose of this section is to get your list up and 

running as quickly as possible. If these instructions are not clear, you can always learn from 

other topics in this manual with Email Marketer Projects for more detailed information. 

Enjoy now! 

3.2 Knowledge Base 

Project 

An Email Marketer project contains all the data of a mailing campaign. It consists of message, 

script, recipients, delivery settings, publish tasks and reports. 

This is the advantage of Email Marketer projects. All project options are saved with the 

recipient list. In other words, if you have interrupted your e-mail sending for any reason, just 

save it as a .mpj project, reload, and execute it from the point where you stopped. There is 
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no need to set its configuration options again - they are already part of the saved project. 

A typical project is started at the design stage where you can create the message contents, 

scripts and distribution lists. After these tasks are completed, the project is published and in 

standby for review. 

Email Marketer project supports password protection. An encrypted project could not be 

opened without correct password. 

The project is stored by file with extension ".mpj". The default project storage folder is 

C:\Program Files\Email Marketer Business Edition\Projects and the sample projects 

are stored at C:\Program Files\Email Marketer Business Edition\Samples. 

Relay Mode Mailing 

Email Marketer supports both direct mode mailing (SMTP server free) and relay mode mailing 

(via SMTP server). 

Relay mode mailing simply means that you have to specify a SMTP server that your e-mail is 

going to be "Relayed" through and establish a mailing account similar to the type of account 

used for Microsoft Outlook and Outlook Express. 

Direct Mode Mailing 

In direct mode mailing, Email Marketer’s build-in SMTP server tries to deliver the email 

directly to the recipient's mail server. The SMTP server of your ISP is not required. The 

sending can multitask up to 256 tasks. Depending on your bandwidth you can send emails 

much faster than sending over your ISP's mail server. All you have to do is specify is a valid 

DNS server. 

Once you send an email by Direct Mode, Email Marketer mail engine queries the DNS server 

for the Mail Exchange Record of the address that you are sending to, and connects directly to 

the remote server. Once it is connected it simply "Drops off" the e-mail. Sending bulk email 

with Direct Mode is surely faster and more efficiently than sending with the Relay Mode. 

You should better configure your DNS setting in the Tools > Preferences dialog if you prefer 

to direct mode mailing. A DNS needs be a valid IP address like '123.12.11.111'. 

Generally, Email Marketer detects and imports the default DNS settings of your network. You 

can also specify the DNS server manually. The following are different options for obtaining 

your DNS settings to type them in manually. 

a) For Windows 95/98/ME users. Click Start->Run. Enter 'WinIpcfg', and press Enter/Return 

key. You can see the present TCP/IP info from where you can find DNS server address.  

b) For Windows NT/2000/2003/XP/Vista users. Click Start->Run. Enter 'cmd' and press 

Enter/Return key. This brings you into the command line mode. Enter 'ipconfig' and press 

Enter/Return key. You can see the present TCP/IP info from where you can find DNS server 
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address. 

Note: 

 For Direct Mode mailing, keep in mind that some mail servers refuse to accept messages 

from person computers, whose IP-Address comes from a dial-up connection or whose 

IP-Address is not a known mailhost (has no DNS-MX-Record). In this case, try Relay or 

Mixed mode mailing instead to avoid delivery failures. 

Mixed Mode Mailing 

In mixed mode mailing, Email Marketer tries to deliver message via both build-in SMTP server 

and you own SMTP server to ensure the messages are as quickly and successfully as possible. 

Terminology 

Message 

Email content, including subject, HTML message, plain text message, attachments, priority 

etc. 

Recipients 

The message targets, who receive the messages. 

Recipient 

One of the recipients. 

List / Contact List 

A database that contains records and fields (attributes) that store personal information about 

each contact. Normally for newsletter subscribers, club members, website users, product 

customer etc. 

Contact 

One of the contacts in a mailing list. 

Group / List Group 

A Group is a subset of Email Marketer mailing list. The grouping function allows you to classify 

specific members of your list based on information you have about them. For example, it 

could help you to send a special message to only those list members who live in Canada. 

Publish 

Sending personalized messages to the recipients. 

Task 

An mailing campaign of defined message and recipients. 
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3.3 Service Monitor 

Email Marketer Service Monitor helps control the scheduler service and the subscriber service. 

Since you must leave the scheduler and the subscriber running all the time in order for it to 

work, this option has been designed to keep the Service window out of the way of the way 

while you complete your other work. 

 

To start Email Marketer Monitor, please click Start -> Programs -> Email Marketer 

Business Edition -> Email Marketer Monitor. 

To close Email Marketer Monitor, right-click on the monitor icon and select Exit. 

By default, Service Monitor launches automatically when Windows starts up. 

4 Mail Accounts 

4.1 Mail Account Management 

Mail on the internet is delivered through what is called an "SMTP server". Before you start 

using a mass email program like Email Marketer, you should decide who (or which server) will 

deliver your e-mail after you send it. We recommend using a dedicated SMTP server. Email 

Marketer has its own build-in SMTP server, but there are some cases where using any internal 

server on your machine to send directly will not work. If you do not know your "SMTP Server 

settings," which are the same settings you would need to set up your "Accounts..." under 

Outlook or Outlook Express, then you may want to go research that information from your 

system administrator or web service provider before you get started. 

Please also note that your Internet Service Provider may have restrictions on how much email 

they wish to send for you. What's more, many ISP SMTP servers are badly overloaded. 

However, most web hosting providers, the people that host your website, also provide SMTP 

server facilities. Using your web host's SMTP server is almost always your best choice. 

A mail account is necessary for sending mails both in Relay Mode mailing or Direct Mode 

mailing. 

Email Marketer supports unlimited mail accounts and it imports your accounts from your 

operating system at the first launch. 
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To create or change your mail accounts, click Mailing Accounts on the lower left hand side 

of the screen. 

 

New 

Creates a new mail account. 

Properties 

Views or changes the settings of selected mail account. You may also double click an account 

item to do this as well. 

Remove 

Removes the selected mail account. Note, projects may not work if the account is referenced. 

Import 

Imports mail accounts from Outlook or Outlook Express. 

Export 

Exports mail accounts to Internet Account files. 

Creating an Account 

To create an account, click the New button in the account list window: 
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Title 

This chooses the display name for the account. Recipients will not see this name so feel free 

to use whatever name suits you. 

Display Name 

This chooses the name for the email account. This name appears in the "From" field of the 

email and will be seen by recipients. 

Email Address 

The email address for the account which appears in the "From" field as well. 

Default Email Account 

Lets you choose which mail account will serve as your default mail account. 
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SMTP Host 

SMTP server host for mail sending. Domain name or IP are both accepted. 

SMTP Port 

SMTP server port for mail sending. The default is 25. 

POP3 Host 

POP3 server host for mail receiving. Domain name or IP are both accepted. 

POP3 Port 

POP3 server port for mail receiving. The default is 110. 

Requires SSL Transfer 

Some SMTP or POP3 servers such as gmail.com support secured data transferring. Check if 

this is necessary. 

User name / Password 

If your server requires authentication, enter the information you normally use for logging into 

your email account. 

Verify 

This validates the account settings you wish to send from. It's strongly recommended that 
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you verify the account before you click OK. You must be online in order to do this. 

 

Connection / Thread count 

Adjusts thread count for delivery, the default is Automatic. 

Retry attempts on delivery failure 

Retry count for resending each failed message delivery. The default is 5. 

Connect and receive timeout 

The maximum delay time to wait for the server reply after a request. If you have low 

bandwidth, 30 seconds timeout or more is required. 

This SMTP server limits the number 

The maximum number of mailings your ISP restricts. 

Sleep when the limit reached 

Sleep to fit the limits of your SMTP server. 

Sleep after each message 

Sleep between messages to control the load balance of mail servers, the default is 5 seconds. 

Sleep between retries 
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Sleep between retries to control the load balance of mail servers, the default is 10 minutes. 

 

Signature for Text Message 

Plain text signature for text based messages. 

Signature for HTML Message 

Rich signature for HTML based messages. 
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HELO/EHLO Name 

The computer or domain name to talk with your or your clients' SMTP servers. 

Custom Email Headers 

Your own email header lines. For information about email headers, please Reference 

http://www.stopspam.org/email/headers.html. 

Removing an Account 

To remove an account, select the account and click the Remove button. 

Note: projects may not work if the associated mailing account was removed. 

5 List Management 

5.1 Using List Manager 

The List Manager helps you build your own permission-based contact lists with just a few 

clicks. You can add contacts manually or automatically to group your list. 

The List Import/Export wizard helps you import or export your list data from Microsoft 

Address books, Microsoft Outlook contacts, Microsoft Excel files or Formatted Text / CSV files, 

http://www.stopspam.org/email/headers.html
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dBase 5 files. 

By default, Email Marketer has a built-in mailing list with the name "Marketer List Database".  

To start the List Manager, click Mailing Lists located on the left hand pane. 

 

Creating and Editing Mailing Lists 

New List 

Opens the wizard which you will use to create a new mailing list. Using this button you will 

connect your marketing list in one of the acceptable file formats and ODBC/OLEDB 

compatible databases. For details, please reference Using The List Wizard. 

Edit 

Changes the selected list properties. 

Fields 

Adds, removes or modifies attribute fields of the selected list. 

Remove 

Removes the selected list. 

Creating and Editing List Groups 

New Group 



Nesox Email Marketer User’s Manual 

 

Copyright © 2010, Nesox Solutions. 37 

Opens the wizard which will guide you through the process of creating a new group. For 

details, please reference Creating a Group. 

Edit Group 

Allows you to make changes to the group settings of the selected group. 

Remove Group 

Removes the selected group. 

Managing Contacts 

New Contact 

Creates a new contact in the active list. 

Remove 

Removes the selected contacts. 

Property 

Allows you to changes the contact profile attributes such as name, email, address etc. 

Refresh 

Reloads the contacts from the list source. 

Tools 

This command contains the following utilities to manage the mailing list. 

 

Columns 

Customizes the list attributes displayed in the view. 



Nesox Email Marketer User’s Manual 

 

Copyright © 2010, Nesox Solutions. 38 

Find by Keyword 

Finds contacts by specified keyword. 

Find by Options 

Finds contacts if the attributes match specified options. 

Find by Query 

Finds contacts by query builder. 

Find Invalid/Valid/Unknown Emails 

Finds contacts by the validation results of the email addresses. 

Validate the Emails 

Validates all email addresses in the list and logs the "Invalid", "Valid", or "Unknown" status of 

each one. 

Import Contacts 

Imports contacts from Outlook, Excel, Access or other formats to the list. 

Export Contacts 

Exports the contacts of the list to Text, CSV, Address Book files or other file formats. 

With Email Marketer Business Edition, it is possible to handle subscribers and unsubscribers 

of a mailing list real-time by using the Subscriber Service. 

5.2 Using the List Wizard 

The List Wizard helps you to connecting to contacts from your existing list databases or files 

directly without importing. For example: CSV files, Excel files, Access database, SQL Server, 

MySQL, Oracle and more ODBC / OLE DB compatible databases. 

To start the List Wizard, click Mailing Lists on the left hand pane and click New List or Edit 

button. 

Step 1 List Data Source 

At the first step of the wizard you must select the type of file or database you will be using to 

create your list. The second step of building your list will be determined by which file format 

you choose to work with. 
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Step 2 For Using an Email Marketer List Database 

If you are using an Email Marketer List Database, you select or create Email Marketer built-in 

formatted list database. 
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Step 2 For Using a Local Database File 

For using local files, you may add or remove list data files for the list and define the file 

formats. 

 

Step 2 For Using ODBC Compatible Database 

For database link of ODBC, select or configure the ODBC connections and specify the user id 

and password to connect to list database. 
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Step 2 For Using OLE DB Compatible Database 

For database link of OLE DB, select the data source including connection string, user id, 

password etc. Email Marketer provides the most usual connection string templates. 

Afterwards you can perform a database connection test. 
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Step 3 List Tables and Fields 

For Local files and database link of ODBC and OLE DB list sources, an additional step is 

required. At this step, you make the settings for the list table, list email address field and list 

name field. You can also customize the query for the list table. 

Custom queries are for advanced users who are familiar with using Structured Query 

Language for finding specific addresses in their database. 

 

After finishing the wizard, a new list connection will be created and all list contacts in the list 

table will be loaded. To create a subset of the mailing list, please reference Creating Groups. 

5.3 Adding contacts 

You may add contacts manually or import contacts from other lists. 

To manually add a contact, click the New Contact button in the List Manager: 
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Click Save to save changes and close the dialog. 

Note: In order to record a new contact you must fill in the email field. Other fields are 

optional. 

To import contacts, see Importing Contacts. 

5.4 Editing Contacts 

To edit the attributes of a contact: 

 Double click the contact row, or 

 Click the Property button located along the bottom of the screen. 

5.5 Removing Contacts 

To remove contacts, select the contact row and click Remove. You may select more than one 

contact to remove at a time by pressing Ctrl + Click and then clicking the Remove button. 

You may also remove all contacts of a group, by selecting the group and then clicking the 

Remove Group button. 
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5.6 Creating a Group 

Groups are subsets of your list. Using the grouping feature allows you to target specific 

members of your list based on information you have about them. For example, you may send 

a special message to only those list members who: 

 live in Canada 

 have made a major purchase in the last year 

 have an email address at a particular domain (e.g., aol.com or hotmail.com) 

Email Marketer allows you to segment you list and send to one or more groups who meet the 

criteria you define. Instead of sending to your entire list, you can use groups to filter exactly 

who should get a message based on whatever criteria you choose. 

To create a list group, click the New Group button in the List Manager: 

 

Name 

The name for the group. 

Notes 

Notes for the group. 

Group Identifier Field 
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The flag field for the group. This field is will be marked with "1" when a contact subscribes to 

the group, marked with "0" when a contact un-subscribes to the group. 

The Group Identifier Field is optional. If it is specified, the group is a static group. Otherwise, 

it is a dynamitic group. 

 

Expressions 

The query rules for the group. 

SQL 

The query string for the group. Please ensure you do not modify the preserved identifier 

"$TABLE". 

5.7 Editing a Group 

To edit a group, click the Edit Group button and modify the group settings: 
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5.8 Removing a Group 

To remove a group, select it and click the Remove Group button. 

Note: The default group "All List Contacts" cannot be removed. Also keep in mind that if you 

remove a static group, all contacts in the group will be also removed. 

5.9 Adding Contacts to Groups 

To add contacts to an existing static group: 

 Select the group and click New Contact or Tools -> Import Contacts. 

To add contacts to an existing static group: 

 Select one or more list contacts in the List view, right click on them and select Groups in 

the context menu.  

 You may select multiple contacts by Ctrl + Click and Shift + Click.  

To remove contacts from an existing static group: 

 Select list contacts in the List view, right click on them and click Remove.  

 You may select multiple contacts by Ctrl + Click and Shift + Click.  

To modify contacts in a dynamic group, you must change the query via List Query Builder. To 
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do this, select the group, click Edit Group and click Query. 

5.10 Exporting Contacts 

Email Marketer allows you to export contacts as well to the following destinations: 

 Microsoft Address Book 

 Microsoft Outlook Contact 

 Microsoft Excel 

 Text / CSV File 

 dBase 5 / DBF file 

 HTML file 

 XML file 

To Export Contacts 

1. Switch to the List Manager by clicking Mailing Lists on the left hand side of the screen. 

2. Click Export from the List menu or click the Tools->Export Contacts button in the List 

Manager. 

3. Follow the guides. 
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5.11 Importing Contacts 

Email Marketer allows you to import contacts step by step from: 

 Email Address List 

 Microsoft Address Book 

 Microsoft Outlook Contacts 

 Microsoft Excel 

 Text / CSV File 

 dBase 5 / DBF file 

If you are using another form of document or program to store your contacts, try exporting 

it to a CSV file first. Then import the CSV file to Email Marketer. 

To Import Contacts 

1. Switch to the List Manager by clicking Mailing Lists on the left hand side of the screen. 

2. Click Import from the List menu or click the Tools->Import Contacts button at the 

List Manager. 

3. Follows the guides. 

 

Cancel 
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Cancels the wizard. 

Previous 

Rolls back to the last step of the wizard. 

Next 

Continues to the next step of the wizard. 

Finish 

Finishes the wizard and closes the dialog. 

CSV Format 

A CSV (Comma Separated Variables) file is a formatted text file with a header row to specify 

the field names. For example: 

name,email,product,purchasedate 

John Doe,jdoe@somewhere.com,Email Marketer Personal Edition,05/02/04 

William Doe,wdoe@somewhere.com,Email Marketer Business Edition,01/06/04 

Most popular applications, including Microsoft Outlook, Microsoft Excel, Microsoft Access, and 

Database systems, support CSV format exporting. 

5.12 Searching contacts 

To search contacts, click the Tools button and select Find by Query at the List Manager, 

Email Marketer will guide you through the searching by the Query Builder. 
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5.13 Validating Contacts 

Email Marketer allows you to validate the email addresses of your contacts to check the email 

visibility. 

To validate contacts, open the List Manager and click the Tools button and select Validate 

the Emails. 
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Threads 

Threads for the validation connections to the recipients' mail server. 

Email for talking 

The email address for talking with the recipients' mail server. 

Status field 

The TEXT or CHAR field to log the validation results. 

Add "Status" Field 

Creates a new field to the mailing list database for results logging. 

Start 

Starts the validation. 

5.14 Customizing the List View 

To customize the view of your contact lists, you may: 

 Sort by clicking the attribute header. 

 Right click the header and click Columns at the context menu. Here you can add or 

remove attributes / columns in the view. 
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To avoid prolonged loading time of a large list, you may also customize the amount of the list 

that will be viewed by clicking the  button on the List Manager. 

 

5.15 Selecting Recipients 

Before you select the recipients, please ensure the mailing list is set properly in the List 

Manager. 

To select recipients for the working project. Click Recipients on the project view header and 

select the appropriate data sources for the To Mailing List and To List Group fields. 

 

Refresh 
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Reload the receipts from the list source. 

Preview Message 

Previews or sends the personalized message for the selected receipt. You may also do this by 

double clicking on the Recipients row. 

Import 

Imports contacts from Outlook, Excel, Access or other formats to the list. 

Export 

Exports the contacts of the list to Text, CSV, Address Book files or other file formats. 

Manage Lists and Groups 

Switches to the List Manager of the selected mailing list. 

6 Project Management 

6.1 Using Project Manager 

The Project Manager helps you manage existing projects. 

To start the Project Manager, click My Projects on the left hand pane. 

 

Open 
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Opens the selected project. 

Shrink 

Shrinks and optimizes the file size of the selected project. 

Remove 

Removes the selected project.  

New Project 

Creates a new project. You will be prompted to pick a built-in template for your message. You 

may also click the Project Wizard button on the dialog to create the new project in wizard 

mode. 

New Project From Template 

Creates a new project. You will be prompted to pick an HTML page as your message content. 

Email Marketer is bundled with hundreds of email templates, they are default located in 

C:\Program Files\Email Marketer Business Edition\Templates folder. 

Import 

Imports an existing project file to the manager. 

6.2 Creating Projects 

Create a Blank Project 

Open the program and click New Project from the Project Manager view. Select Default and  

the program will guide you directly to the General view of a new project. Alternatively, you 

may click File > New (Ctrl+N) menu. 

Create a Project from Templates 

Open the program and click the File menu. Then, select New from Template. You will be 

prompted to pick an HTML page as your message content. Email Marketer is bundled with 

hundreds of email templates, they are default located at C:\Program Files\Email Marketer 

Business Edition\Templates folder. 

Create a Project by Wizard 

Email Marketer also provides Project Wizard feature for you to enhance and expedite the 

project creation procedure with step by step guides. To start the project wizard, select File > 

Project Wizard menu. 
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Title 

The title for the project. 

Description 

The description for the project. 

Unique Id 

The unique project identifier. 

Re-create 

Recreate the project unique id. 

Compression 

The compression level of the project file, options are None, Fastest, Default and Maximum. 

Compressing a project will cause slower loading and saving while shrinking the project file 

size. 

6.3 Using Project Wizard 

The Project Wizard helps you to enhance the project creation procedure. To start a project 

wizard, select File > Project Wizard menu. 
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The wizard window is resizable. 

Cancel 

Cancels the wizard. 

Previous 

Rolls back to the last step of the wizard. 

Next 

Continues to the next step of the wizard. 

Finish 

Finishes the wizard and close the dialog. 

Step 1 

At the first wizard step, general information is required. 

 

Project Title 

Title for the campaign. You could specify the title to be the same as the message subject. 

Description 

Optional memo for the project, used in reports. 
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Step 2 

At the second wizard step, you may choose a content template for the project. 

 

Step 3 

At the third wizard step, you may choose a style template for the project. 
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Step 4 

At the forth wizard step, you can define the publish settings. 
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From Account 

The mail account for sending messages. 

Reply To Account 

The mail account for receive incoming email replied by your recipients. Generally, it is same 

as the From Account. 

Content Type 

Indicates the format of your email. It could be Plain text, HTML or both. 

Delivery Mode 

The way you send your messages. To learn more about delivery mode, please reference 

Direct Mailing, Relay Mailing and Mixed Mailing. 

Mailing List 

The mailing list of recipients. 

Step 5 

The Wizard finishes and you will be guide to the project views. 
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7 Composing Messages 

7.1 Using Message Editor 

The built-in Message Editor supports all e-mail standards, and thus, you can use it to 

compose Text or HTML type messages, attach an unlimited number of files, and enjoy many 

other features. 

When you want to add special emphasis or structure to message text such as bold text, color, 

or bulleted lists, you can use Hypertext Markup Language (HTML), the standard for 

formatting text for the Internet. HTML messages are different from text messages since they 

can contain formatted text, tables, pictures, and dynamic elements like animations, flashes, 

etc. HTML messages are basically web pages. Therefore, everything that can be done on web 

pages can be done in HTML messages as well. 

The HTML editor is simply "What You See is What You Get". Basically, you set up the page and 

see how it looks with different elements such as text, images, forms, tables, etc. The editor 

will then automatically make the HTML coding for you. This can be nice, however, keep in 

mind that much of the HTML code is usually unnecessary for the actual functioning and can’t 

be modified. Serious web developers or designers, would do better not using the HTML editor 

because many like to have a very specific say in how their HTML code ends up. However, 

applying HTML editing improves an author's control of format and appearance, and can also 

help authors work effectively without knowing HTML. By using HTML editing, users can simply 

click buttons to alter paragraph formats, font sizes, typefaces, font weights, colors, and so 

on. 

HTML Editing provides the following functionality to the user: 

 Importing from a local or online web page. 

 Importing from an .eml file. 

 Standard editing functionality such as caret positioning, keyboard navigation, drag and 

drop, and content selection. 

 Copy, cut, delete, and paste operations. 

 Unlimited undo and redo. 

 The ability to toggle selected text between bold, italic, and/or underlined. 

 The ability to alter typeface, font size, fore color, and background color. 

 The ability to remove formatting. 

 The ability to increase or decrease indentation. 

 The ability to justify text (left, center, right). 
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 The ability to create ordered and unordered lists. 

 The ability to create a hyperlink or bookmark. 

 The ability to insert inline personalization scripts. 

 The ability to insert a horizontal line. 

 The ability to insert an image. 

 The ability to insert a flash. 

 The ability to insert a table. 

 The ability to insert a variety of intrinsic controls. These include buttons, text boxes, 

radio buttons, check boxes, submit controls, and drop-down and list boxes. 

Users can exploit the HTML editing as a means to generate proper and consistent HTML and 

XML code. The HTML editor generates standard HTML, allowing third-party applications to 

quickly adapt the latest Microsoft browser features. 

To compose your message by Message Editor, click Message in the project explorer window. 

 

From 

Selects the From account for the message. If no account is listed, you may need to create an 

account. 

Reply To 
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Selects the Reply To account for the message. If no account is listed, you may need to create 

an account. 

To 

Selects the email field of the recipients list. 

Subject 

The subject for the message. 

Messages 

The WYSIWYG message editor view, you may click Text Message, HTML Message or HTML 

Source to switch between the editor views. 

Text Message 

Switches to plain text editor for plain text message. 

HTML Message 

Switches to WYSIWYG rich message editor for HTML message. 

HTML Source 

For advanced users, switches to view or edit the source code of HTML message. 

Preview 

Opens the message preview and delivery test window. 

Attachments 

The attachments view as icons. 

Add 

Adds an attachment file to the message. 

Remove 

Removes the selected attachment from the message. 

Advanced, Tracking Settings 

Specifies the message format (HTML format, Plain text format or both), priority, encoding. 

You can also enable campaign tracking feature by this command. 

Note 

When you use formatted HTML and the recipient's e-mail or news program cannot read HTML, 

the message appears as plain text with an HTML file attached. Most e-mail programs that 

support Multipurpose Internet Mail Extensions (MIME) can read HTML formatting. 

7.2 Inserting Scripts 

To insert inline personalization scripts blocks into the message subject or message body: 

1. Click the place in the message or subject where you want the script to execute or merge. 

2. Click the Insert menu and select Personalization Script. 
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3. Enter scripts and click OK. 

To check to syntax of the scripts you inserted, press F9 or click the Message menu and select 

Check Script Syntax. 

 

(The window could be resized) 

If you do not know much about the script programming, Email Marketer could help you create 

simple scripts with the following easy way: 

To insert script for outputting a field of the contact 

row 

1. Click the place in the message or subject where you want to insert. 

2. On the Insert menu or the context menu, select Contact Attribute Script. 

3. Pick a field option (for example: "FirstName"). 

To insert script for predefined variable 

1. Click the place in the message or subject where you want to insert. 

2. On the Insert menu or the context menu, select Variable Script. 

3. Pick a variable option (for example: "MY_HOMEPAGE"). To customize the variable, please 

reference Variable Settings. 
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7.3 Inserting Pictures 

To insert a picture to the HTML message: 

1. Click the place in the message where you want the image to appear. 

2. Click the Insert menu and select Image, click the Browse button and pick a picture 

file. 

3. Change layout or spacing settings if needed. 

To modify a picture already inserted, double click the picture. 

When a prepared HTML message is included in the message, Email Marketer automatically 

finds all the pictures, sounds and adds them to the message. When the recipient receives thus 

formatted message, his/her e-mail program will find the encoded pictures in it and open them 

immediately without downloading them from the Internet first. 

 

Location / URL 

The location of the picture to insert. You may use a picture from your computer or just enter 

the URL of the picture if it has been uploaded to your web server. Embedding a picture is 

easier for your recipients, while linking to an online picture is recommended for faster send 

performance. 

Alternate Text 

The text you want displayed in place of the image when images are turned off or are 

unavailable on the recipient's computer. The alternate text is also displayed when the image 

is loading. 

Alignment 

The position of the picture on the page. 
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Border Width 

Places a border around the picture with specified width in pixels. 

Border Color 

The color of the picture border. 

Horizontal 

Adds the specified amount of space in pixels to the sides of the image. 

Vertical 

Adds the specified amount of space in pixels to the top and bottom of the image. 

Notes 

 To insert a background picture into your message, on the Format menu, click Page 

Property. Click the Browse button besides the Background Image field to search for 

the picture file you want to use. You can also insert background sounds on this menu as 

well. 

7.4 Inserting Hyperlinks 

To insert a hyperlink to the HTML message, click the Insert menu and select Hyperlink. 

To create a hyperlink from existing message text, simply select the text before you create the 

hyperlink. 

To edit an existing hyperlink, click within a hyperlink and choose Hyperlink from the Insert 

menu. 

URL 

The hyperlink of the URL. For example, "http://www.nesox.com". 

Hint Text 

The text for hint when the cursor is hovering on the hyperlink. 

Type 

Hyperlink type. For example, select the "mailto:" type after entering "support@nesox.com" 

for the URL. This creates a link that will automatically open up you recipients default mail 

client with an email addressed to wherever you choose. 

Target 

Target window to browse the hyperlink when your recipients clicks on it. 
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7.5 Inserting Tables 

To insert a table to the HTML message, click the place in the message where you want the 

table to appear and click the Table menu and select Insert Table. 

 

In the dialog, you can customize the caption, row / column count, width, border, cell padding 

/ spacing, background of the table. 

To operate with rows or columns of a table, please reference The Table Menu. 

For complex table editing, you may want to export the message and edit it with a professional 

editor such as FrontPage or DreamWeaver. You may then re-import the message after it has 

been edited. 

7.6 Inserting Signature 

To edit the signature, please click Mailing Accounts and double click your "From" account. 
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To insert the signature to the HTML or text message, click the place in the message where you 

want the signature to appear and click the Insert menu and select Signature. 

7.7 Inserting Unsubscription Link 

Email Marketer supports list unsubscription automation and can process all email requests for 

subscription or unsubscription. 

To edit the unsbuscritpion text and link, please: 

1. click Subscriber Service; 

2. select your mailing list and click New to create a processor; 

3. edit the Subscriber Text and Subscriber HTML. 
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For more information about the unsubscription link, please reference Creating Forms and 

Links for Subscribing and Unsubscribing. 

To insert the unsubscription link to the HTML or text message, click the place in the message 

where you want the link to appear and click the Insert menu and select Unsubscription 

Text and Link. 

7.8 Formatting Text 

To change the font, style, and size of text 

You can change the way the text looks for all your messages or you can make changes to 

selected text within a message. 

1. Select the text you want to format. (To change the font for an entire message, on the 

Edit menu, click Select All.) 

2. On the formatting toolbar, click the buttons for the options (Font, Style Size, etc...) you 

want. 

To remove formats of text 

1. Select the text you want to clear. 
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2. On the Format menu, click Remove Format. 

To format a paragraph 

1. Click anywhere in the paragraph, or select the text that you want to format. 

2. Use either the formatting toolbar or the commands on the Format menu to change the 

text. 

3. To change the indentation of the paragraph, click the Increase Indent or Decrease 

Indent button on the formatting toolbar. 

4. To format the style of the paragraph, on the Format menu, point to Text Style, and 

then choose an option. 

To add a horizontal line 

Click the place where you want the line to appear, and then click Insert menu and select 

Horizontal Line. 

To create a numbered or bulleted list 

1. In your message, click the place where you want the list to start. 

2. On the formatting toolbar, click either Numbered List or Bulleted List. 

3. Type the first item in the list. When you press ENTER, another list entry is started on the 

next line. 

4. To end the list, press ENTER twice. 

7.9 Importing and Exporting 

Importing from URL 

To import an online html page, click the Message menu and select Import From URL, enter 

the URL of the page. 

(for example: "www.google.com", "http://www.nesox.com/en/email_marketer.asp"). 

Importing from File 

To import a local html page, click the Message menu and select Import From File. Email 

Marketer is bound with many rich email templates. You can find them in the Templates and 

Styles folder under the installation directory. 
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Importing from Email 

To import an email，click the Message menu and select Import From Email. An email 

message can normally be stored in .eml or .msg file format. 

Exporting to File 

To export the message you have edited, click the Message menu and select Save To File. 

7.10 Message Settings 

To customize the message settings, click the Advanced, Tracking Settings button from the 

message editor. 

 

Mail Charset 

The character set of your message. 

Mail Format 

The format of your message, you may choose plain text, HTML or both. 

Mail MIME Type 

The MIME type for encoding your email messages, Base64 is recommended. 

Mail Priority 

The priority of your message. 
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Request read receipts 

To be notified when the recipient opens your message. 

 

Email Marketer Business Edition can track the behavior of your recipients with the assistance 

of our tracking service. To enable tracking for the project, please click Track the message 

opens and hyperlink clicks and click OK to apply. 

8 Personalizing Messages 

8.1 Personalization Script Introduction 

Email Marketer can execute VBScript like code within the mail text while the emails are being 

generated. This means that you can control the contents of each individual email with your 

own programming. 

You access the objects of the email by means of several Email Marketer script objects. As a 

result of this, you can easily: 

 output text 

 attach file attachments to the e-mail 

 modify the subject / body 

 load texts/templates from a file 

 access the current user attributes 
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 access an external database via ADO 

 read or write files 

 control the mailing process 

 save the message object to file 

 and more... 

This means that you will be able to manage the following tasks, for example: 

 different title for different user gender 

 all recipients of the domain xyz.com can receive a different text content 

 all of those interested in the product xyz can receive specific product information as an 

attachment 

 and more... 

Prerequisites 

You will need at least some programming skills of VBScript. 

Nesox Solutions cannot offer any support for VBScript programming. We would however be 

happy to advise you of the available possibilities and to give you brief indications as to 

whether or not you can implement a particular request and how to go about doing so. 

Inline Script Block Masking 

A Script Block is masked by the following character string: 

<% Script-Code %> 

An e-mail can contain several Script Blocks and one global script. Any VBScript-Code can be 

specified within this marking. 

VBScript Language Reference Guide 

A language reference guide to VBScript can be found in the MSDN Library. 

We have also attached a chm formatted reference in the installation directory. 

Notes concerning protection of registered trademarks 

The VBScript technology is the property of the Microsoft Company. Integration into this 

application has been possible thanks to the outstanding interfaces available with this 

technology. 

http://msdn.microsoft.com/library/default.asp?url=/library/en-us/script56/html/vbscripttoc.asp
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8.2 Global Personalization Script 

Global Script is a little different from the Inline Script, it is designed to give you overall control 

of the message contents. 

With global script, you can easily send different attachments to different people, or send 

differently formatted message to different people. You can use your database to compute the 

name of the attachment to use. You can set up a computed field in your database that 

depends upon the content of other fields and chooses the name for the attachment. Then, you 

can attach a file from a field in your database. 

Using the advanced scripting, you can treat the attachment filename as a string, and perform 

operations on it such as concatenation and string replacement. Email Marketer's attachment 

function is just a regular function defined in whatever scripting language you are using. 

To edit global scripts, click Scripts from the project view header. 

 

List Fields 

This section lists the attribute fields located within the contact list of you have selected for this 

project. 

Functions 

The VBScript functions list. 
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8.3 Scripting Objects Reference 

Email Marketer utilizes two power objects for personalization; Message and User. With these 

objects, you can easily control the entire message if you want. Normally, the scripting objects 

are used for global personalization scripting. 

The Message Object Model 

The message object is available to you within the Personalization Script Code with the 

following properties and methods: 

Property Type Description 

FromName Text 

Read/write the display name of the sender, the default value is 

loaded from the sender account. 

Example 

Message.FromName = "Nesox Solutions" 

FromEmail Text 

Read/write the email address of the sender, the default value 

is loaded from the sender account. 

Example 

Message.FromEmail = "someone@nesox.com" 

ReplyName Text 

Read/write the display name of the reply-to, the default value 

is loaded from the reply-to account. 

Example 

Message.ReplyName = "Nesox Solutions" 

ReplyEmail Text 

Read/write the email address of the reply-to, the default value 

is loaded from the reply-to account. 

Example 

Message.ReplyEmail = "someone@nesox.com" 

Subject Text 

Read/write the message subject. 

Example 

Message.Subject = Message.Subject & " for " & 

User("FirstName") 

CC Text 

Read/write the email for carbon copy recipients. 

Example 

If User("AlternativeEmail") <> "" Then Message.CC = 

User("AlternativeEmail") 

BCC Text 

Read/write the email for blind carbon copy recipients. 

Example 

Message.BCC = "someone@nesox.com" 
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Message.BCC = "someone1@nesox.com; 

someone2@nesox.com" 

Text Object 

Access the plain text message, Message.Text is a Body object. 

For more details, please reference Body. 

Example 

Message.Text.LoadFromFile "c:\newsletter1.txt" 

Html Object 

Access the HTML message, Message.Html is a Body object. For 

more details, please reference Body. 

Example 

Message.Html.LoadFromFile "c:\newsletter1.htm" 

Format Text 

Read/write the message format, "Text", "Html" or 

"Automatic". 

Example 

Message.Format = User("Format") 

Body Object Equals Text or Html object for inline scripting. 

Attachments Object 

Access the attachments in the message. 

Example 

Message.Attachments.Add "c:\news.pdf" 

Cancelled Bool 

Know whether the delivery of this message is cancelled. 

Example 

If Message.Cancelled Then MsgBox Message.Email & " was 

cancelled." 

DateTime Datetime 

Read the last operation time for the message. 

Example (for success or failure messages block) 

Set Sys = CreateObject("Scripting.FileSystemObject")

Set Txt = Sys.OpenTextFile("c:\mylog.txt", 8) 

Txt.Write(Message.Email & ": " & Message.DateTime & 

vbCrlf) 

Txt.Close 

ErrorNumber Number 

Read the error number for a failure or cancelled message. 

Example (for failure messages block) 

Set Sys = CreateObject("Scripting.FileSystemObject")

Set Txt = Sys.OpenTextFile("c:\mylog.txt", 8) 

Txt.Write(Message.Email & ": " & Message.ErrorNumber 

& " " & Message.ErrorText & vbCrlf) 

Txt.Close 

ErrorText Text Read the error description for a failure or cancelled message. 
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Example (for failure messages block) 

Set Sys = CreateObject("Scripting.FileSystemObject")

Set Txt = Sys.OpenTextFile("c:\mylog.txt", 8) 

Txt.Write(Message.Email & ": " & Message.ErrorNumber 

& " " & Message.ErrorText & vbCrlf) 

Txt.Close 

UserKey Text 

Read the key field value of the recipient. Used for calling back 

after delivery. 

Example (for success messages block) 

Message.ListConnection.Execute "UPDATE List SET 

DeliveryTime=Now() WHERE Email='" & Message.Email & 

"'" 

Email Text 

Read the email address of the recipient. Used for calling back 

after delivery. 

Example (for success messages block) 

Message.ListConnection.Execute "UPDATE List SET 

DeliveryTime=Now() WHERE Email='" & Message.Email & 

"'" 

ListConnecti

on 
Object 

ADO database connection object for the mailing list. 

Example 

Set Sys = CreateObject("Scripting.FileSystemObject")

Set Txt = Sys.OpenTextFile("c:\mylog.txt", 8) 

Txt.Write(Message.Email & ": " & Message.DateTime) 

Txt.Close 

Method Returns Description 

Reset Nothing Clear the message contents and attachments. 

Cancel Nothing 
Cancel the message personalization and creation and this 

message will not be delivered. 

The Body, Text, HTML Object Model 

The body object equals to the current Text or Html object. It is only accessible for inline script. 

For global scripting, use Message.Text or Message.Html instead. The Body object is available 

to you within the Personalization Script Code with the following properties and methods: 

Property Type Description 

Text Text 

Access the plain-text character-string or HTML source codes. 

Example 

Message.HTML.Text = "<b>Hello!</b>" 

Method Returns Description 
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Write Nothing 

Append text to plain-text content or HTML source codes. 

Example 

Body.Write "String" 

Special Notice 

For inline scripting, ="String" equals to Body.Write "String" 

WriteLine Nothing 

Append text with line break to plain-text content or HTML 

source codes. 

Example 

Body.WriteLine "String" 

InsertFromFi

le 
Nothing 

Insert the contents of a text/html file at this position. 

Example 

Body.InsertFromFile "c:\copyright.htm" 

LoadFromFile Nothing 

Overwrite the message text with the contents of a text/html 

file. 

Example 

Body.LoadFromFile "c:\newsletter1.htm" 

Clear Nothing 

Empty the message text. 

Example 

Message.Text.Clear 

Message.Html.Clear 

End Nothing 

Stop generating this message text. 

Example 

Message.Text.End 

Message.Text.WriteLine "String"  ' this will not work 

any more 

SaveToFile Nothing 

Save the message text to a text/html file. 

Example 

Message.Html.SaveToFile "c:\" & User("Email") & ".htm"

Message.Text.SaveToFile "c:\" & User("Email") & ".txt" 

The Attachments Object Model 

Property Type Description 

Count Number Read the attachments amount. 
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Method Returns Description 

Add Nothing 

Add a new attachment by its location. 

Example 

Message.Attachments.Add "FilePath" 

Remove Nothing 

Remove an attached file by its file name or index. 

Example 

Message.Attachments.Remove "FilePath" 

Clear Nothing 

Remove all attached files. 

Example 

If User("NoAttachment") = "1" Then 

  Message.Attachments.Clear 

End If 

Find Number 

Find attachment by its file name and returns the index. 

Example 

If Message.Attachments.Find("FilePath") >= 0 Then 

  Message.Attachments.Remove "FilePath"  

End If 

The User Object Model 

The attachments object is available to you within the Personalization Script Code with the 

following properties and methods: 

Property Type Description 

Properties Text 

Read/Write the recipient's attributes from a specific column as 

a character-string. Returns the contents of the current value 

from this column as a variant-type. 

(contains NULL values, numbers, dates, etc.) 

Example 

Message.Subject = User.Properties("FirstName") & ", " 

& Message.Subject 

Special Notice 

1. User("fieldname") equals to 

User.Properties("fieldname") 

2. For inline scripting, [fieldname] also equals to 

User.Properties("fieldname") 
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Email Text 

Read/Write the recipient's email address. 

Example 

If User.Email = "" And User("AlternativeEmail") <> "" 

Then 

  User.Email = User("AlternativeEmail") 

End If 

FullName Text 

Read/Write the recipient's full name. 

Example 

If User.FullName = "" Then 

  User.FullName = User("FirstName") 

End If 

Key Text 

Read/Write the recipient's key field. 

Example 

If User.Key <> "" Then 

  Message.HTML = Replace(Message.HTML, "#key#", 

User.Key) 

End If 

Connection Object 

ADO database connection object for the mailing list. 

Example 

Set rs = Connection.Execute("SELECT OrderNo FROM Orders 

WHERE UserID=" & User("ID")) 

User("OrderNo") = rs("OrderNo") 

Method Returns Description 

Clear Nothing 

Remove all user attributes in the object. 

Example 

User.Clear 

8.4 Inline Personalization Script Examples 

A Simple Example 

<% 

For i = 1 To 100 

 Body.WriteLine i & vbCrLf 
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Next 

%> 

Show all attributes of the User 

<% 

For i = 0 To User.PropertyCount - 1 

 Body.WriteLine i & ":" & User.Properties(i) 

Next 

%> 

Recipients of the domain "xyz.com" receive an 

included text from a file 

<% 

If InStr(1, User("Email"), "@xyz.com", vbTextCompare) <> 0 Then 

 Body.LoadFromFile "d:\mails\abc.txt" ' path must be changed 

Else 

%> 

 Standard Text or HTML 

<% 

End If 

%> 

Those interested in the product "xyz" receive a file 

attachment 

<% 

If User("InterestXYZ") = True Then 

 Message.Attachments.Add "d:\productinformation\productxyz.pdf" ' path must 

be changed 

End If 

%> 
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* This assumes your database contains an attribute field "InterestXYZ" in boolean type. 

Congratulations to recipients whose birthday is today 

<% 

If IsDate(User("birthday")) Then 

 Dim dtBirthDay 

 dtBirthDay = CDate(User("birthday")) 

 If Month(dtBirthday) = Month(Now) And Day(dtBirthday) = Day(Now) Then 

  Message.Subject = Message.Subject & " (Happy birthday!)" 

  ' Insert a card file with congratulation 

  Body.LoadFromFile "d:\birthday.txt" ' path must be changed 

 End If 

End If 

%> 

8.5 Global Personalization Script Examples 

Different attachments to different recipients 

Message.Attachments.Add "C:\Program Files\Email Marketer Business 

Edition\Samples\" & User("ID") & ".xls" 

* This assumes you have created an excel file for each user. 

Different message format to different recipients 

If User("Format") = "text" Then 

 Message.Format = "text" 

ElseIf User("Format") = "html" Then 

 Message.Format = "html" 

Else 

 Message.Format = "automatic" 

End If 

* This assumes the "Format" field is included in your list table. 
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9 Tracking Messages 

9.1 Tracking Service 

Email Marketer Tracking Service is an online HTTP service for monitoring the opening of 

messages and the clicks on the links in a message. With the tracking service, Email Marketer 

can provide you with real-time email clickthru and HTML open tracking reports. 

Email Marketer Tracking Service works with Email Marketer Business Edition only. 

You may either rent the service hosted on Nesox Solution's server or order the tracking 

service program and install it to your own server. 

To request a 30-day free trial tracking account, please visit http://service.nesox.com. 

To learn more details or order the tracking service, please visit 

http://www.nesox.com/en/service.asp. 

9.2 Tracking Server Connection Management 

To create or change a tracking server connection, click Mailing Accounts on the left pane 

and click the New button on the lower right hand side of the screen. 

 

New 

Creates a new tracking service connection and account. 

http://service.nesox.com/
http://www.nesox.com/en/service.asp
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Properties 

Views or changes the selected tracking service account. 

Remove 

Removes the selected tracking service account. 

 

Server Name 

The host of the selected tracking server, enter a domain name or IP address. 

Server Port 

The port of the selected tracking server, the default is 80. 

Server Time Zone 

The time zone of the selected tracking server. For example, if the server is located in Australia, 

the time zone should be Sydney. 

The default time zone is acquired from your operating system. 
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User Id 

User Id for your tracking service account. 

Password 

Password for your tracking service account. 

Test Connection 

Verifies the existence of the selected tracking server. If the server is successfully validated, 

your tracking account information will be reported. 

Note 

To mark your project/messages trackable, you should configure and validate the tracking 

servers for the project before you sending out the messages. 

9.3 Enable Tracking of a Campaign 

Click the Advanced, Tracking Settings button from the message editor to specify a 

tracking server connection to track message opens and link clickthrus. 
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If no connection is selected, the tracking feature will be disabled; else, Email Marketer will 

automatically connect and notify tracking requests to the selected tracking server. 

9.4 Tracking Results 

To retrieve tracking results from the tracking server and integrate them into the project, 

simply click the Refresh button of the Reports tab. You will be prompted with "Tracking 

results were successfully updated by N records!" after the retrieving. 

10 Sending Messages 

10.1 Preview and Test 

It is strongly recommended that you preview and test the message to check how it looks 

before launching the email marketing or newsletter campaign. 

There are two ways to do this: 

1. Switch to the Recipients view of the project and click the Preview button. 

2. Switch to the Publish view of the project and click the Test button. 
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From 

The sender's name and email for the message. 

To 

The recipient's name and email for the message. 

Subject 

The subject after personalization for the message. 

Attachments 

The attachments view as icons. 

Size 

The total size of the message. 

Previous 

Previews the message of the previous contact. 

Next 

Previews the message of the next contact. 

View 

Views the message as Plain Text, HTML or Source. Opens the message as an email client 
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application such as Outlook or Outlook Express would. 

Send This Message 

Sends the message with detail delivery log. 

Close 

Close the message preview window. 

10.2 Sending the Messages 

Email Marketer can quickly and easily deliver a great number of personalized email messages 

directly to the recipients list, without using your ISP Internet SMTP relay server, because 

Email Marketer is a self-sufficient SMTP relay. (You may use your own SMTP server if you want 

to as well, if you want to). Thanks to this feature, Email Marketer gives you INSTANT feedback 

on every message sent. In other words, you can instantly verify which emails addresses are 

not functioning and discard the invalid recipients of your list. 

If you are an Email Marketer Business Edition user, Email Marketer can also help you 

scheduling send the messages. 

To send the messages, please click Publish at the header of the project window and click the 

Start button. 

 

New Task 
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Creates a new task using the existing publish options. 

Remove 

Removes the selected task. Note all messages logs in the task will be also removed. 

Options and Performances 

Customizes the mailing account performances, the delivery mode, thread count and more 

performance related settings. 

Schedule 

Schedules the publish task of the project. 

View Message / Log 

Views or resends the selected message. 

Start / Resume / Stop 

Starts or stops the campaign task, of sending the personalized messages to receipts. 

Note: When a delivery task is completed, the Start button will be disabled. To send the 

messages and enable the Start button again, please click New Task button. 

Note: You may click the X button of the main window to minimize the application to the 

system tray area during the sending progress. 

Test 

Tests the delivery to a specified email address. 

Export 

Exports the email addresses or delivery details in the view. 

10.3 Resuming Interrupted or Failure Mailings 

If you have stopped publishing (sending) your project in the middle you may resume from 

where Yeshiva left off. When you stopped and saved the project, the Start button will have 

turned to Resume when you reopen the project. 

Generally, Email Marketer will try to resend the failures automatically unless you click the 

Stop button. 

There are two options to resend the failures manually from the Publish tab: 

1. If the Resume button is enabled, just click it to resend the failures; 

2. If the Resume button is disabled, please click the Options and Performances button 

and add to the retries field. Then click Resume; 

3. To resend a single failure message, please click Failure Details and double click the failure 
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item. Click the Send This Message button at the new dialog. 

10.4 Options and Performances 

To enable multi-SMTP delivery or to change the delivery settings, please click the Options 

and Performances button at the Publish view. 

 

Delivery Mode 

The way you send your messages. To learn more about the delivery mode, please reference 

Direct Mailing, Relay Mailing and Mixed Mailing. 
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Connection / Thread count 

Adjusts thread count for delivery. The default is Automatic. 

Retry attempts on delivery failure 

Retry times for resending each failed delivery. The default is 5 times. 

Connect and receive timeout 

The maximum delay time to wait for the server reply after a request. If you have low 

bandwidth, 30 seconds timeout or more is required. The default is 60 seconds. 

This SMTP server limits the number 

The maximum number of mailings your ISP restricts. 

Sleep when the limit reached 

Sleep to fit the limits of your SMTP server. 

Sleep after each message 

Sleep between messages to control the load balance of mail servers. The default is 5 seconds. 

Sleep between retries 

Sleep between retries to control the load balance of mail servers. The default is 10 minutes. 
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11 Scheduler Service 

11.1 Scheduler Service 

The Scheduler Service can help you schedule the mailing of a project. 

The scheduler included with Email Marketer Business Edition can be used to automatically 

generate and send an e-mail merge at a specific time only once, or it can be cycled to 

generate and send an e-mail every few days, hours, or minutes. 

The main Scheduler window will list the tasks set to run, the current status of those tasks, the 

last time each task was run, and the next time the task is set to run. Tasks can be sorted by 

any of these fields. 

You will need to keep the Scheduler Service running in order for it to send mailings as you 

planned. 

 

Note that you can place a shortcut to the Email Marketer Monitor in your Startup Items 

folder and start the Service automatically, should you need to shut down or restart your 

computer. We recommend doing this if you have an ongoing schedule. 

11.2 Adding Project to Scheduler 

To schedule a project scheduling task, click on Scheduler Service on the left pane and then 

click New. 
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Task Properties 

You can set the options for a task by first selecting the task and then double clicking it. 

Email Marketer Scheduler provides five choices to execute your task: Once / Daily / Weekly / 

Monthly / Yearly. 

Note: You will need to keep the Scheduler Service running in order for it to send mailings as 

you planned. 

11.3 Removing Project from Scheduler 

To remove a project from the scheduler, please: 

1. Click on Scheduler Service on the left pane. 

2. Find and select the scheduled project. 

3. Click the Remove button. 

12 Subscriber Service 

12.1 Subscriber Service 

The Subscriber Service in Email Marketer Business Edition helps you handle subscribe and 

unsubscribe requests real time. 
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You will need to leave the Subscriber Service running in order for it to monitor requests 

automatically. 

To start the List Subscriber Manager, click Subscriber Service on the left pane. 

 

New 

Creates a new subscriber processor for the selected mailing list. 

Property 

Views or changes the settings of the selected subscriber processor. 

Remove 

Removes the selected subscriber processor. 

Subscription Form Wizard 

Creates subscription web forms in wizard mode. 

Check Mailboxes 

Receives and handles all requests from specific mailing accounts. 

View Message 

Views the detail email of the selected request. 

Export 

Exports the email addresses in the view. 
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12.2 Creating Forms and Links for Subscribing 

and Unsubscribing 

Ready to Create Forms and Links 

1. Create two email addresses for receiving subscribe and unsubscribe requests. For 

example: you may choose subscribe@example.com and unsubscribe@example.com; 

2. Click Mailing Accounts at the left pane and create two mailing accounts for the above 

email addresses; 

3. Click Subscriber Service at the left pane and click the New button to create a new 

subscriber processor for subscribe requests. You may specify the mailbox as 

subscribe@example.com, the subject keyword as "subscribe" and the action as 

"Subscribe the sender to a mailing list or group". 

4. Click the New button again to create another subscriber processor for unsubscribe 

requests. You may specify the mailbox as unsubscribe@example.com, the subject 

keyword as "unsubscribe" and the action as "Remove the sender from a mailing list or 

group". 
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Creating and Releasing a Subscription Form 

1. Click Subscriber Service at the left pane and click the Subscription Form Wizard 

button. This will help you create the subscription form step by step. 

2. Specify the Form Name field, also select your web server type and click the Next button. 

Normally, a subscription form works in ASP or PHP scripting. 

 

3. Select the opt-in and opt-out processor you want to work with. You can also specify one 

or more list attributes for the subscription form. Click the Next button. 
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4. In this screen, you can change the subscription form settings and customize some text in 

your own language. Click the Next button and this will preview the form. Make sure it 

looks ok and click the Next button again. 

 

5. The wizard completes and all scripts for the subscription form will be created. 
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6. Click the Browse Script Files button and upload all scripts to your website root folder 

"nesox". 

7. Open your web browser and enter "http://www.yourwebsite.com/nesox/form.htm" to 

the address bar to test the web form. If it works, you can integrate the source codes of 

form.htm to any page in your website. Note: If your website supports ASP or PHP 

scripting, an email request will be created and sent by the scripts directly in background 

when the form is submitted. Otherwise, it is created and sent to your mailbox by the 

client email program. 

8. You can change the form settings by editing 

http://www.yourwebsite.com/nesox/preferences.ini file instead without uploading the 

scripts again. 

Creating and Inserting Unsubscription Links 

1. Click Subscriber Service at the left pane and select an opt-out type processor. Double 

click on it or click the Property button and click the Options tab; 

2. Customize the Text or HTML to your specifications; 

3. To insert the unsubscribe link to your message, please open the project and click the 

Message tab, right-click or click the main menu Insert and select Unsubscription 

Text and Link. 
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Processing the Requests 

1. At Subscriber Service, click the Check Mailboxes button scan and process the 

requests. 

2. Alternatively, you may keep the Subscriber Service active at the Service Status and 

requests will be handled every 5 minutes. 

3. Contacts will be added or removed from your mailing list database. 

4. Note: You must make sure the mailing accounts for your subscription services are not set 

up on your Outlook or Outlook Express program. These email client programs (and any 

other similar email client) will receive/download all of the email requests in the mailbox. 

Email Marketer will not be able to find anything when checking the mailbox and your list 

subscription requests can not be processed if this happens. 

Note that you can place a shortcut to the Email Marketer Monitor in your Startup Items 

folder and start the Service automatically, should you need to shut down or restart your 

computer. We recommend doing this if you have an ongoing schedule. 

12.3 Creating a Subscriber Processor 

To add a subscriber processor, click on Subscriber Service on the left pane and click New. 

Fill in the information appropriately. 
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12.4 Removing a Subscriber Processor 

To remove a subscriber processor, please: 

1. Click on Subscriber Service on the left pane; 

2. Find and select the subscriber processor; 

3. Click the Remove button. 

13 Reports 

13.1 Creating Project Reports 

Email Marketer provides live tracking on all email campaigns you send out. Reports are an 

integral part of the campaign process. Real-time results tell you everything you need to know 

to measure the success of your campaign and tailor future campaigns for even better results. 

Reports consist of a: 

 Summary Report 

 Message Report 
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 Recipients Report 

 Report for Overall Responses and Results by Task 

 Report for Overall Responses and Results by Date 

 Report for Overall Responses and Results by Link 

 Report for Task Details 

 

Browse 

Selects the logo of your organization, the logo will be included in the reports. 

Refresh 

Downloads tracking results if available and recreate the reports with live data. 

Print 

Prints the report page. 

Print Preview 

Prints preview the report page. 

View by Web Browser 

Opens the report index with your default web browser. 
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13.2 Creating List Reports 

Email Marketer provides live reports for multiple mailing lists. The reports tell you everything 

you need to know to measure your list growth. 

To create or view list reports, click List Reports on the left pane. 

 

Generate 

Create the reports with live mailing list data. 

Print 

Prints the report page. 

Print Preview 

Prints preview the report page. 

View by Web Browser 

Opens the report index with your default web browser. 

13.3 Sample Reports 

Please visit http://www.nesox.com/en/email_marketer_report.asp. 

http://www.nesox.com/en/email_marketer_report.asp
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13.4 Terms 

Delivers 

The amount of success newsletter deliveries in the campaign. 

Failures 

The amount of failure newsletter deliveries in the campaign. 

Total Opens 

The times of your newsletters are opened by the recipients. The number may higher than the 

number of recipients because the recipient may open your newsletter twice or more. 

Total Clicks 

The times of the hyperlinks in your newsletters are clicked by the recipients. The number may 

higher than the number of recipients because the recipient may click different links in your 

newsletter. 

Unique Opens 

The times of your newsletters are opened by the recipients. If the recipient opens the 

newsletter for twice or more, it is calculated for once only.  

Unique Clicks 

he times of the hyperlinks in your newsletter are clicked by the recipients. If the recipient 

clicks a same link for twice or more, it is calculated for once only. 

Clicked Users 

The amount of recipients who click one or more links in your newsletters. 

14 Preferences 

14.1 Preferences 

Preference settings control the appearance and operation of Email Marketer. You can access 

most preferences from the Tools > Preferences... dialog. Preference settings are grouped 

in pages of related settings and the pages are listed in the dialog by category. 



Nesox Email Marketer User’s Manual 

 

Copyright © 2010, Nesox Solutions. 103 

 

Click the category title to display the related preference pages (such as Variable page). Select 

a preference page to view and change individual settings. 

Load Defaults 

Restores the default settings. 

OK 

Applies changes and closes the dialog. 

Cancel 

Ignores changes and closes the dialog. 

Apply 

Applies changes. 

Note: While changes to most settings take effect immediately, some changes take effect after 

Email Marketer has been closed and restarted. Email Marketer will notify you if this is the 

case. 
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14.2 General Settings 

 

Show new file wizard 

Opens the project wizard at startup. 

Create new project 

Creates and opens a blank project. 

Detect new version 

The application will try to find upgrades online upon startup. 

Desktop 

Creates or removes a shortcut to Email Marketer Administrator on your desktop. 

Start Menu 

Creates or removes a shortcut to Email Marketer Administrator on your Start menu. 

Send To Menu 

Creates or removes a shortcut to Email Marketer Administrator on your Send to menu. The 

send to menu appears in the context menu when you right click an Email Marketer project. 

Pagination 

The records page size for reports. 

Logo 
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The default logo file for project and list reports. 

14.3 Project Settings 

 

Default project folder 

Projects under this folder will be automatically detected at startup. The default folder is 

C:\Program Files\Email Marketer Business Edition\Projects. 

Create backup file when saving 

Creates a project backup with ".mpj.bak" file extension. 

Generate report automatically after send 

Generates project reports once a publish task is completed. 

Save project automatically 

Saves project after changes of the project were made. 

Creates general publish log 

Creates a text-based log file for your delivery. 

Creates detail publish log for each connection 

Creates text-based log files for each connection. The log files record the conversations 

between the application and SMTP servers. You may choose to create detail logs if you 

experience error during the delivery. 
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14.4 Composer Settings 

 

Optimize file size before saved 

Shrink the size of your HTML message. 

HTML source syntax highlight 

Highlights HTML tags such as <BODY>, <TABLE>, <FONT> in the HTML source editor. 

Spelling check before publish 

Checks the spelling of your messages before they are sent. 

Font 

The font for HTML source editor. 
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14.5 Message Settings 

 

Mail format 

The default format of your message, you could choose plain text, HTML or both. 

Mail charset 

The default character set of your message. 

Mail mime type 

The default mime type for encoding your email messages, Base64 is recommended. 

Mail priority 

The default priority for your message. 

X-Mailer 

The X-Mailer identity in your message header. 

Default content template 

Default content template that applies to a blank project. 

Default style template 

Default style template that applies to a blank project. 
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14.6 Connection Settings 

If your network is behind a firewall, you may need to establish Internet connection through a 

proxy. 

 

Enable socket proxy / agent 

Enables or disables a proxy to the Internet connection. 

Socket version 

The version of your proxy protocol, Socks 4 or Socks 5. 

Host 

The IP address for the proxy server. 

Port 

The port for the proxy server. 

Authentication 

Checks if the proxy server needs authentication. 

User name 

User name to access the proxy server if the server needs authentication. 

Password 

Password to access the proxy server if the server needs authentication. 
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Test 

Tests the proxy settings. 

14.7 DNS Settings 

If you prefer to Direct Mailing mode, DNS settings are needed to query mail exchange 

information. A DNS must be a valid IP address like '123.12.11.111'. Email Marketer read DNS 

settings from Windows by default. You can also inquiry your ISP or network master for the 

DNS settings. 

 

Preferred DNS Server 

IP address for preferred DNS Server. It is recommended you enter a local DNS in your local 

network. 

Alternate DNS Server 

IP address for secondary DNS Server. This setting is optional. 

Detect 

Acquires and fills DNS servers from your network automatically. 

Test 

Tests if the DNS servers work or not. 

Query timeout 

Timeout for querying a mail exchange record. The default is 5 seconds. 
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Query retry 

Retry count for querying a mail exchange record. The default is 10 times. 

Buffer MX Exchange query results 

Queries buffered results in the application instead of always querying the DNS server. DNS 

caching speeds up your delivery. 

Clear MX Exchange buffer before publish 

Clears the buffer before you start a mailing task. 

14.8 Variable Settings 

Variables could be used in personalization scripts. Here you can create or modify unlimited 

variables settings. 

 

New 

Creates a new variable. 

Edit 

Changes the selected variable name or value. 

Remove 

Removes the selected variable. 
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15 User Interfaces 

15.1 Overview of User Interfaces 

Standard 

Like most Windows applications, Nesox Email Marketer user interfaces consist of menus, 

toolbars, status bar and control panes. 

The status bar always displays information about the current state of what is being viewed in 

the window or any other contextual information, such as the keyboard state. 

By clicking the menu View > Toolbars > Customize, you may adjust the style, size or icon 

of the menu and toolbars. 

Wizard-based 

Most Email Marketer's user interfaces are wizard-based. Wizards such as Project Wizard, 

Recipients Wizard, Import Wizard, Export Wizard and the Upgrade Wizard guide you through 

every step of the action you'd like to perform. 

Multi-languages 

Currently, Email Marketer has been formatted to perform in several languages. To switch 

system language, just click the View menu and select Languages. To create your own 

localized language pack, please reference the readme.txt under the Languages folder. 

15.2 The Main Window 

Once you start the application, you will be taken to the main window of the Email Marketer 

Administrator: 
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The window displays of the following areas: 

Menu Area 

Shows menu commands. 

Toolbar Area 

Shows toolbar button commands. You can also use drag and drop to float a toolbar. 

Project Explorer Area 

Shows and switches of project views. 

Project View Area 

Shows project view. If no project is opened, show project lists and guide. 

Tip of the Day Area 

Shows tip of the day. 

Status bar Area 

Shows current application status, including: help text, editor cursor, copyright, etc. 

15.3 The File Menu 

This menu contains Email Marketer Administrator's project related commands: 
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New 

Creates new project from a HTML template or opens a recent project. 

New from Template 

Creates new project from a self-defined HTML template. 

Project Wizard 

Creates new project by wizard. 

Open 

Opens an existing project. 

Save 

Saves the active project. 

Save As 

Saves the active project to another location. 

Close 

Closes the active project. 

Print Preview 

Previews how the message will print. 

Print 

Prints the mail message. 

Exit 

Quits the application. 
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15.4 The Edit Menu 

Using the edit menu, you can perform all the well known text operations such as cut, copy, 

paste, and undo etc. 

 

Undo 

Use this command to reverse the last editing action, if possible. 

Redo 

Use this command to reverse the last undo, if possible. 

Cut 

Cuts the selection to the Clipboard (Ctrl + X). Use this command to remove the currently 

selected data from the document and put it on the clipboard. This command is unavailable if 

there is no data currently selected. Cutting data to the clipboard replaces the contents 

previously stored there. 

Copy 

Copies the selection to the Clipboard (Ctrl + C). Use this command to copy selected data into 

the clipboard. This command is unavailable if there is no data currently selected. Copying 

data to the clipboard replaces the contents previously stored there. 

Paste 

Pastes the contents of the Clipboard to the current location (Ctrl + V). Use this command to 

insert a copy of the clipboard contents at the insertion point. This command is unavailable if 

the clipboard is empty. 

Select All 

Selects all text. 

Invert Selection 

Reverses which items are selected and which are not. 
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15.5 The Message Menu 

From the message, you can perform the operations of the Message Editor. 

 

Find 

Searches for the specified words or codes in the message. 

Find Next 

Searches for the occurrence of the specified words or codes in the message. 

Replace 

Replaces the specified words or codes in the message. 

Goto Line 

Jumps to the specified line of HTML message source. 

Save To File 

Saves the message to a specified file. 

Import From File 

Replaces the message with the content of a specified file. 

Import From URL 

Replaces the message with the content of a specified online page. 

Import From Email 

Replaces the message with the content of a specified email file. 

Extract Text from HTML Message 

Replaces the text message with the text extracted from the HTML message. 
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Check Spelling 

Starts the spell checker. 

Check Script Syntax 

Checks the personalization script syntax in the message. 

15.6 The Format Menu 

From the format menu, you can perform HTML format operations such as font, alignment and 

color etc to the message. 

 

Text Style 

Changes the text paragraph style of current selection. 

Text Format 

Changes the text format of current selection. 

Remove Format 

Removes the text format of current selection. 

Bold 

Toggles Bold formatting for current selection or adds <b></b> tag to HTML source. 

Italic 

Toggles Italic formatting for current selection or adds <i></i> tag to HTML source. 

Underline 

Toggles Underline formatting for current selection or adds <u></u> tag to HTML source. 

Justify Left 
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Aligns text at the left indent. 

Justify Center 

Centers text between margins. 

Justify Right 

Aligns text at the right indent. 

Font Property 

Changes the font and character spacing formats of current selection. 

Increase Indent 

Increases the indent of current selection. 

Decrease Indent 

Decreases the indent of current selection. 

Snap to Grid 

Snaps the selection to grid. 

Make Absolute 

Makes the selected picture or form control absolute. 

Page Property 

Changes the page property such as background image, language and border etc. 

15.7 The Insert Menu 

From the insert menu, you can insert various types of media into the message. 
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Contact Attribute Script 

Inserts personalization script with contact attribute. 

Variable Script 

Inserts personalization script with user defined variable. 

Personalization Script 

Inserts personalization script with an editor. 

Horizontal Line 

Inserts a horizontal line. 

Image 

Inserts a picture into the message from a specified file. 

Hyperlink 

Modifies the selection and formats it as a hyperlink. 

Bookmark 

Modifies the selection and formats it as a bookmark. 

Table 

Inserts a table. 

Flash 

Inserts a Macromedia Flash into the message from a specified file. 
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Special Character 

Inserts special HTML characters. 

Unsubscription Text and Link 

Inserts unsubscription text and link created by Subscriber Service. 

HTML 

Inserts HTML codes. 

15.8 The Table Menu 

From the table menu, you can insert or modify a HTML table in the message. 

 

Insert Table 

Inserts a table. 

Insert Row 

Inserts a row in the selected table. 

Insert Column 

Inserts a column in the selected table. 

Insert Cell 

Inserts a cell in the selected row or column. 

Delete Rows 

Deletes the selected rows of the table. 

Delete Columns 

Deletes the selected columns of the table. 

Delete Cells 



Nesox Email Marketer User’s Manual 

 

Copyright © 2010, Nesox Solutions. 120 

Deletes the selected cells of the table. 

Merge Cells 

Merges the selected cells of the table. 

Split Cells 

Splits the selected cells of the table. 

15.9 The List Menu 

 

New Group 

Creates a new group by wizard. 

Remove Group 

Removes the active group. 

Group Property 

Changes the group definition of the active group. 

New Contact 

Creates a new list contact. 

Remove Contact 

Removes the selected contacts. 

Contact Property 

Allows you to change the contact profile attributes such as name, email, address etc. 

Search 

Searches the contacts by query builder. 

Import 

Imports contacts from excel, access and other database to the list. 
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Export 

Exports the contacts of the list to file or database. 

15.10 The View Menu 

From the view menu, you can customize the windows, menus and toolbars etc of the user 

interface. 

 

Languages 

Switches system language. To create your own specialized language pack, please reference  

readme.txt under Languages directory. 

Toolbars 

Shows or hides the specified toolbar. 

Toolbars | Customize 

Customizes the style of toolbars and allows you to add, remove and change the order of the 

toolbar buttons. 

Status Bar 

Shows or hides the status bar. 

Navigator 

Shows or hides the explorer pane. 

Borders 

Shows or hides the borders of the elements in the rich message. 

Document Details 

Shows or hides the details of the elements in the rich message. 

Zoom 

Zooms the message editor. 
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15.11 The Tools Menu 

From the tools menu, you can change the settings of the application. 

 

Free Trial Official Tracking Service 

Requests an account and begins 30 day free trial of the tracking service provided by Nesox 

Solutions. 

Email Marketer Monitor 

Starts Email Marketer Service Monitor. 

Install Email Marketer Services 

Installs Scheduler Service and Subscriber Service to Windows. 

Shrink Project 

Shrinks and optimizes the size of a specified project file. 

Protect Project 

Protects the active project with a password. 

Protect Software 

Protects the software with a password. 

Query MX Records 

Queries Mail Exchange information by a domain or email address. 

Preferences 

Multiple configurations can be done through this command. For details about Configuration 

Window, please refer to Configuring Email Marketer. 

Backup Data and Settings 
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Backup mailing lists, projects and software settings. 

Restore Data and Settings 

Restores mailing lists, projects and software settings. 

15.12 The Help Menu 

 

Help Contents 

Opens the user's manual. That is, this document. In the help dialog, select the Contents tab 

to see a hierarchical list of topics; the Index tab to view topics listed in alphabetical order, or 

the Find tab for a full-text search of the Help system. 

VBScript Language Reference 

Opens the VBScript user's manual. The personalization script is based on VBScript. 

What's this? 

Shows "What's this" help. 

Tip of the Day 

Shows or hides the Tip of the Day window. 

Check for Update 

Checks for available updates of Email Marketer. 

Order 

Opens the ordering form. By choosing to register Email Marketer, your web browser will be be 

opened and you will be automatically directed to the reseller's web site. 

Register 

Once you have a registration key, this is where you type it in. 

Email Marketer Online 
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Visits the home page of Email Marketer. 

About Email Marketer 

Shows version, registration and copyright information of Email Marketer. 

15.13 The Main Toolbar 

 

Buttons (from left to right): 

New    Creates new project from a HTML template or opens a recent project. 

Wizard    Creates new project in wizard mode. 

Open    Opens an existing project. 

Save    Saves the active project. 

Print    Prints the mail message. 

Mail Accounts  Creates, removes or modifies mailing accounts and tracking accounts. 

Exit    Quits the application. 

15.14 The Editor Toolbar 

 

Buttons (from left to right): 

Font Name  Changes the font name of current selection. 

Font Size   Changes the font size of current selection. 

Text Style   Changes the text paragraph style of current selection. 

Copy    Copies the selection to the Clipboard (Ctrl + C). Use this command to copy 

selected data into the clipboard. This command is unavailable if there is no data currently 

selected. Copying data to the clipboard replaces the contents previously stored there. 

Paste   Pastes the contents of the Clipboard to the current location (Ctrl + V). Use 

this command to insert a copy of the clipboard contents at the insertion point. This command 

is unavailable if the clipboard is empty. 

Cut    Cuts the selection to the Clipboard (Ctrl + X). Use this command to 

remove the currently selected data from the document and put it on the clipboard. This 

command is unavailable if there is no data currently selected. Cutting data to the clipboard 
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replaces the contents previously stored there. 

Bold    Toggles Bold formatting for current selection or adds <b></b> tag to 

HTML source. 

Italic    Toggles Italic formatting for current selection or adds <i></i> tag to HTML 

source. 

Underline   Toggles Underline formatting for current selection or adds <u></u> tag to 

HTML source. 

Color    Changes the color of current selection. 

Align Left   Aligns text at the left indent. 

Center        Centers text between margins. 

Align Right   Aligns text at the right indent. 

Numbered List  Switches current paragraph to numbered list. 

Bullet List   Switches current paragraph to bullet list. 

Decrease Indent  Decreases the indent of current selection. 

Increase Indent  Increases the indent of current selection. 

Insert Image  Inserts a picture into the message from a specified file. 

Insert Anchor   Modifies the selection and modifies it as a hyperlink. 

Check Spelling  Starts the spell checker. 

Check Script Syntax Checks the personalization script syntax in the message. 

15.15 The Help Toolbar 

 

Buttons (from left to right): 

Preferences   This command controls multiple configurations. For details about the 

Configuration Window, please refer to "Configuring Email Marketer".  

Project Navigator  Shows or hides the project view navigator.  

Check For Update  Checks for available updates of Email Marketer.  

Help Contents  Opens the user's manual. That is, this document. In the help dialog, 

select the Contents tab to see a hierarchical list of topics; the Index tab to view topics listed 

in alphabetical order, or the Find tab for a full-text search of the Help system. 
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16 Troubleshooting 

16.1 I have a problem. What should I do? 

First of all, make sure you have the latest version of Email Marketer. Your problem might have 

been a bug which has already been fixed. 

 Run Email Marketer Administrator 

 Click the Help | About menu 

 Check your Email Marketer version 

 Compare it with the latest version posted at 

http://www.nesox.com/en/email_marketer.asp 

download it if they are different. 

 Otherwise, ask for support. 

16.2 Emails not being sent 

 Try to send a message to yourself, so that it will be easier to detect the problem. 

 Try disabling antivirus software on your computer, which may block the connections to 

your email servers. 

 If you are behind a firewall or proxy, ask your network administrator how to configure 

Email Marketer properly. 

 Check your server account information - Your email, at the Mailing Accounts window, 

should be VALID. Most SMTP servers will refuse to deliver messages from invalid or 

banned senders, also known as SPAMMERS. In this case, try changing your sender data 

like SMTP user name and password. 

16.3 Emails not being received 

Step one 

1. Use a valid email address in Mailing Accounts, bounce address. Some ISPs now accept 

email only when the sender address contains a valid Internet domain name. 

2. Don't use commercial language which may be inadvertently trapped by spam filters: 

3. Don't use the word "free" or words in all caps, and excessive use of exclamation points 

4. Personalize the message subject 

5. Try adding unsubscribe text in the message body 

http://www.nesox.com/en/email_marketer.asp
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6. Make sure you're not trying to send through an AOL dialup connection. AOL blocks mail 

programs other than its built-in one. 

If this is not working 

1. We suggest installing a free, easy to use SMTP server on your own server. 

2. In Email Marketer Administrator, under Mailing Accounts, select the account and click 

Properties. Under SMTP Host, enter the server domain or IP address and SMTP account 

information. 

If it's still not working 

Some ISPs block port 25, the port used by outgoing mail (SMTP), and require you to send via 

their mail server only. You can check with your ISP's support staff re: port 25 blocking. 

 

To use your ISP's mail server: In Mailing Accounts, choose your account and click 

Properties. Set the radio button to Send through external server. Click Settings and fill in the 

outgoing mail (SMTP) server your ISP has provided. 

Some ISPs now accept email only from registered mail servers. Registered mail servers have 

a fixed (static) IP address and a mail server registration (MX record). You have a couple of 

options: 

 

Without direct mailing: Use your ISP's mail server. In Mailing Accounts, choose your 

account and click Properties. Fill in the outgoing mail (SMTP) server your ISP has provided. 

 

With direct mailing: Get a domain name and register the PC as the mail server for the domain. 

This is called adding an MX record. Your ISP or domain registrar can help you with upgrading 

your Internet account to get a static IP address, a domain name and an MX record. 

1. A few ISPs require a reverse DNS record in addition to the standard MX record. Again, 

your ISP or domain registrar can assist you. 

2. Some ISPs limit the number of emails that can be sent per hour, even if you use direct 

send. Emails over this limit will time out with a can't connect message. Check with your 

ISP whether this is the case. If so, go to Tools / Preferences, change the 

connection/thread count to 1 and change interval between retries to 3 seconds or longer. 

3. Make sure your IP address is not on the same block of IP addresses as a blacklisted 

spammer. Popular blacklists include the MAPS RBL. 

16.4 Speeding up send 

The #1 factor in send speed is the speed of your SMTP server. 

http://mail-abuse.org/rbl
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Suitable Delivery Mode 

 Do not use relay mode mailing except if you have a very fast SMTP server. Try direct 

mailing or mixed mailing if the SMTP server of your mailing account is not exclusive. 

 If you have multiple SMTP servers, you may create multiple mailing accounts and click 

Options and Performances from the Publish window to enable them. 

 Avoid using an external SMTP server on the Internet, as this slows down send speed. We 

recommend this free, easy to use one for ease of use and this one for speed. 

 Click Mailing Accounts on the left pane and select your account. Click Properties and 

make sure the thread count and pause after each message are set all the way to the 

right. 

 For direct mode sending, you should define faster DNS servers. A local DNS server is 

usually recommended. 

 Make sure the PCs running Email Marketer and the SMTP server both have plenty of 

memory and hard disk space and a high-bandwidth Internet connection. 

 Disable delivery logging by unchecking Tools | Preferences | Project | Create detail 

publish log. 

Small Message 

 Don't embed images, link to them on a Web server instead 

 Don't attach files 

 Send as plain text: In Message view, click the Advanced, Tracking Settings button 

and select the mail format to Plain Text only.  

 Turn off tracking: uncheck Track feature from the Advanced, Tracking Settings 

button. 

Faster List Database 

 Open your database file in Microsoft Access 2000 or later, click Tools | Fix and 

Compress Project to shrink the project database. 

 Turn off sorting: Click the sorted column's header once or twice from Recipients window 

until the list is no longer sorted. 

Disable Antivirus and Firewall 

 Turn off email scanning in your antivirus program, e.g. Norton AntiVirus, while the 

mailing is being sent. 
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 Turn off your personal firewall logging while the mailing is being sent. 

Other 

 Split your list and run the software on two or more computers. (multiple licenses might 

be needed). 

16.5 Sending to AOL users 

If your mailing list includes recipients at AOL, you must either link to all images or embed all 

images for them to appear in your AOL recipient's email. You cannot mix linked and 

embedded images in a single email. This is a limitation of the AOL email program. 

You can also optionally send plain text only to AOL recipients. 

17 Frequently Asked Questions 

17.1 General 

Q. Can I use Email Marketer to send SPAM 

(unsolicited bulk email)? 

No. Absolutely not. Spam is untargeted advertising. Email Marketer End User License 

Agreement prohibits using Email Marketer for spam. If you want to spam, please go 

elsewhere. Follow the link http://www.nesox.com/en/email_marketer_antispam.asp for 

more information. 

Q. How can I get opt-in lists for email marketing? 

You can use Email Marketer's list manager feature to build your own opt-in lists, it's very easy. 

Q. Is your online order form secure? 

Yes, it is 100% secure. 

Q. Do I have to pay for the upgrades? 

No! All upgrades are free to our software registered users. 

Q. Is tech support free? 

Yes! It's free for all. 

http://www.nesox.com/en/email_marketer_antispam.asp
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Q. What happens after I send in the order? 

You will receive an email confirming your order shortly after sending the online order form. 

Then, within 24 hours, you will receive a second email with your registration name, company, 

code, and instructions to get started! 

Q. Is Email Marketer "Spyware"? 

Email Marketer does NOT collect user information. It respects the user privacy and security. 

Email Marketer can eventually send and receive ID packets to nesox.com. For the sake of 

privacy, no information on the user will be provided to nesox.com. No e-mails will be sent you 

regarding your Email Marketer usage. The only purpose for this is so that nesox.com can 

inform (through a prompt that will appear when open Email Marketer) you about new 

upgrades to your Email Marketer version. You may choose to download it or not. We won't bug 

with numerous questions and insistence - The prompt will only appear when there are 

upgrades to the software; NOT every time you open the program. In fact, we don't even know 

who you are when you use Email Marketer. 

Q. I have other questions not listed here, how can I 

get help? 

Please read this FAQ / Help carefully. If you still have questions, please visit our website or 

consult with us. Click here to look for more information of support. 

17.2 Installation 

Q. Can my computer run Email Marketer? 

To install and use Email Marketer, please make sure that you use the following hardware and 

software platform. 

- Pentium 133 MHz or higher processor 

- At least 32MB of available RAM 

- At least 7MB of free disk space 

- Operating System: Microsoft Windows 98/NT/ME/2000/2003/XP/Vista 

- TCP/IP based Internet network connection 

- Microsoft Internet Explorer v5.0 or above 
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Q. To run Email Marketer, need I install any 

third-party software? 

If your operating system is Microsoft Windows 98, to install and use Email Marketer, you 

should have MDAC (Microsoft Data Access Components) and JET (Microsoft Jet Components) 

installed on your system. You can download MDAC from Email Marketer downloads page. 

(When using Windows ME/XP/2000/2003/Vista you don't need to install anything. All 

required drivers are already installed.) 

Q. Is the version I am using the latest? 

You can check for new version or updates by selecting menu: Help | Check For Update. 

Q. Should I uninstall the previous version before 

upgrading to a new version of Email Marketer? 

No, you don't have to. Email Marketer installer will upgrade itself automatically as long as the 

install path is same as that of the previous version. 

17.3 Messages 

Q. Can Email Marketer send messages with inline 

images or background music? 

Yes. With Email Marketer's built-in WYSIWYG HTML editor, you can easily include graphics, 

change font colors and sizes, add tables, and perform a myriad of functions. You can even 

spice up your HTML messages by adding fair-sounding background music or sound. 

Q. If the images included in my email are stored in my 

local hard drive, need I upload these image files to a 

web server in order for the recipients can see them? 

No, you needn't. Email Marketer can automatically send images included in your message as 

inline image, which means all images are sent along with your message, when your recipients 

open your email, they will see these pictures immediately without waiting for the email 

software to download these images from internet. 

http://www.nesox.com/en/email_marketer_downloads.asp
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Q. How can I create a HTML message? Does Email 

Marketer provide a WYSIWYG HTML editor? 

Yes, Email Marketer provides a fully WYSIWYG (What You See Is What You Get) HTML editor 

to let you create HTML emails. 

Q. I don't understand HTML, how can I design a 

professional-looking HTML message? 

Email Marketer comes with a large number of free, powerful templates. Templates make it 

easy to insert pictures, logos and colors for professional-looking campaigns that grab readers' 

attention. No design or HTML knowledge required. You choose the style, fill in the blanks with 

text and images, and we do the rest, including automatic Text conversion. 

Q. Can I send a test email to myself before launching 

the email campaign? 

Yes. Email Marketer allows you to send a test copy of your message to yourself to ensure it 

looks the way you want. 

Q. Can I directly import a HTML file created by 

another HTML editor to Email Marketer? 

Yes. You can import a HTML file to Email Marketer from your local hard drive by clicking the 

menu Message > Import From File. 

Q. Can I import a web page (eg. My home page) to 

Email Marketer from the Internet? 

Yes. You can even import a web page into Email Marketer from a URL address by clicking the 

menu Message > Import From URL. 

Q. Can I request a read receipt for my message? 

Yes, of course. 
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Q. Does Email Marketer support to sending 

attachments? If it does, how many attachments can I 

add? 

Yes. There is no limitation on the number of attachments one email can have in Email 

Marketer, however, some mail servers do have that limitation. 

Q. Can I send personalized messages to my recipients 

with Email Marketer? 

Yes. Use your contact list to store more attributes than just names and email addresses. By 

using personalization scripts, attributes can be incorporated wherever you wish, throughout 

your campaign. Email Marketer will automatically merge the right attributes for each contact, 

so every message is personalized including the attachments. Email Marketer sends its 

messages directly to each customer, one at a time, personally and privately. The recipients 

only see what they need to see, and they sure don't see the other names on your mailing list. 

Q. Can I personalize the "To" and "Subject" line? 

Yes, you can do this just the same as you can do it in the message body. 

Q. Is the personalized field limited to recipient's 

email? Can other fields be used to personalize my 

message? 

All of the attribute fields of your contact list can be used to personalize your message. 

Q. My message contains non English language, will it 

be ok? 

Yes. Email Marketer supports all international character sets and languages. When you 

compose a non English message, you should select the corresponding character set for this 

email. 

Q. Can I insert an unsubscribe link in my email? 

Yes. However, only the Business Edition supports this. The Subscriber Service in Business 
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Edition can help you create subscription forms and unsubscribe links. 

Q. How can I create a Text / HTML mixture message? 

Choose "Automatic" content type for the message and fill in the text message in the message 

editor. 

Q. Does Email Marketer display Unicode (double-byte) 

charsets, like Chinese, Japanese, etc. properly? 

Yes it does. Email Marketer supports more than 30 different languages / charsets. All you 

need to do is to pick the corresponding charset in the message editor. And if you are sending 

HTML messages, click Format | Page Property and select the Language. In this HTML 

source example we're using the JAPANESE Shift_JIS charset: 

<meta http-equiv="Content-Type" content="text/html; charset=Shift_JIS"> 

17.4 Lists 

Q. What is list manager? 

The concept of using list manager is very simple and straightforward. Simply add a subscribe 

icon to your site inviting visitors to subscribe or sign up. When visitors click on the icon, a 

window pops up requesting their contact information. That information is automatically 

added to a contact list in your Email Marketer account.  

Q. Can list manager store more information of users 

than just name and email? 

Yes. List manager can store as many attributes as you want, in any format. For instance, you 

can set up a contact list which contains customers' name, gender, email, phone number, zip 

code, birthday, country, hobby. etc. The more information you collect, the more you can 

personalize your message for each recipient. Please note, there is no limitation on how many 

fields one contact list can have. 

Q. What is a group? 

Groups are subsets of your list. They allow you to target specific members of your list based 

on information you have about them. For example, they could allow you to send a special 

message to only those list members who: 

 live in Canada 
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 have made a major purchase in the last year 

 have an email address at a particular domain (e.g., aol.com or hotmail.com) 

Email Marketer allows you to send to one or more groups, of your list who meet the criteria 

you define. Instead of sending to your entire list, you can use groups to filter exactly who 

should get a message based on whatever criteria you choose. 

Q. How many users can I set up? 

You can create as many lists as you want in Email Marketer. 

Q. Can I append new users to an existing group? 

Yes. You can append new users to Email Marketer's list from almost all data repositories. 

Q. How can I set up my own permission-based lists? 

You can use Email Marketer's list manager feature to build your own opt-in lists, it's very easy. 

Q. I have stored my customer's data in a Microsoft 

Access / Excel table, can Email Marketer access these 

data? 

Yes. Email Marketer can import contact lists from almost all data repositories, including text 

file, CSV file, Excel table, Access, SQL Server, Oracle, DB2, MySQL, FoxPro, and all ODBC / 

OLEDB compatible database systems. 

17.5 Subscription 

Q. Besides the subscriber's email address, can list 

manager collect other information of the subscriber? 

Yes. You can collect as many attributes of your subscriber as you want with Email Marketer's 

list manager feature. 

Q. Can I specify mandatory (required) items in the 

sign-up form? 

Yes, you can. You can customize the entire sign-up form. 
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Q. Can I validate the content in the sign-up form 

entered by subscribers? 

Yes, you can. Email Marketer provides format validator for email, number, date, time etc. 

Q. Can I validate the email address entered by a 

subscriber is correct and owned by himself. 

Yes. Email Marketer supports for double opt-in, that is, It will automatically send an email to 

subscribers requesting that they confirm before adding them to the contact database. 

17.6 Delivery 

Q. What is a SMTP server? 

An SMTP server is a program that receives e-mail messages from the e-mail client program 

and forwards them to their destination. When you send messages from your e-mail program, 

they are not delivered directly to the recipient. Instead, they are first downloaded by an 

intermediary, i.e. an SMTP server, which then ensures that they are sent to the right recipient. 

Every time you send a message, there are four factors involved in the exchange: 

 

1. Your e-mail program in which the message was generated 

2. SMTP server which forwards the message to its correct destination  

3. Remote server that receives the message from the SMTP server and from which the 

recipient will subsequently download it  

4. E-mail program of the recipient which downloads the message from the server. 

Q. Do I need a permanent Internet connection to use 

the program? 

No. Email Marketer works with any Internet connection. It will also work if you are connected 

to the Internet via modem and dial-up networking. In that case, it can, if necessary, connect 

to and disconnect from your ISP automatically. 

Q. How fast does Email Marketer send? 

There is no short answer to this question. There are many variables that affect message 

throughput, and since sending a piece of mail requires that you communicate with the 

recipients mail server, some of these variables may not be under your control at all. Sending 

email involves at least four distinct variables: 
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 The actual message being sent (size, encoding, etc...)  

 The speed of the computer creating the mail (CPU, HD subsystem, memory, etc)  

 The speed and responsiveness of SMTP server which receives the messages  

 The speed of the Internet connection between your computer and the recipient's mail 

server  

Each of these variables contributes to the overall speed of the sending. Any of the variables 

has the potential to slow the things down to the point where sending bulk email is absolutely 

impossible. 

Q. Can I send out emails without SMTP servers? 

Yes. Email Marketer's "direct delivery mode" doesn't use your mail server or your ISP's mail 

server. Instead, It connects and sends messages to the mail server of the recipients' address. 

For instance, a message from bob@aol.com is sent directly to mail.aol.com instead of 

mail.yourdomain.com. This takes the load off of your mail server and speeds up message 

sending significantly. 

Note: If your ISP (or firewall) blocks TCP port 25, Direct Sending won't work. 

Q. What is Multi-SMTP-Server delivery mode? 

Of course, you can also use one or more of your SMTP servers to deliver your message. This 

mode supports multiple SMTP servers and can automatically balance the load between these 

SMTP servers. 

Q. What is mixed delivery mode (Direct delivery with 

backup SMTP server)? 

This delivery mode sends messages directly at first, if the direct delivery fails, then Email 

Marketer will use the backup SMTP servers you assigned to send the message again. With this 

delivery mode, you can avoid overloading your SMTP servers as well as improve the sending 

success ratio dramatically. 

Q. If I assign more than one SMTP server to an email 

campaign, how will Email Marketer use these 

servers? 

If you assign multiple SMTP servers to send out your messages in "Multi-SMTP-Server 

delivery mode" or "Mixed delivery mode", Email Marketer can automatically balance the load 
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between these servers. For instance, if you have 1000 messages to be sent and you assign 10 

SMTP servers to do the job, then each server will handle about 100 messages. This feature 

takes the load off of your SMTP servers and speeds up message sending significantly. 

Q. What is the benefit of letting Email Marketer 

periodically sleep during mailing process? 

Some mail servers limit emails one IP address can send during an amount of time. To cope 

with this, Email Marketer introduces a special delivery mode which can periodically slow down 

Email Marketer's fast email sending in order to allow slow Mail Servers to "catch their breath". 

This optional feature can help avoid overloading the slow mail servers and improve the 

sending success ratio dramatically. Note: Email Marketer is the ONLY bulk email software with 

this feature at the present time. 

Q. I have to stop Email Marketer during of the mailing 

task. Can I resume the task? 

Yes. You can stop a running mailing task at any time. Email Marketer can automatically 

recover the interrupted mailing and resume where you left off. 

Q. Can I resend the failed emails? 

Yes. Once you've finished sending your emails, you can easily resend the failed emails. Some 

emails cannot get delivered not because the email address is invalid, but because the Internet 

offers many impassable obstacles: 

 the recipient's email server may be temporarily down 

 the recipient's inbox is full 

 your ISP may be temporarily down 

 an Internet segment may be temporarily down 

 a DNS server may be temporarily down 

 Resending the failed emails can improve the sending success ratio significantly. 

Q. Is Email Marketer a multithreaded application? If 

so, how many threads can I create? 

Yes, Email Marketer is a multithreaded application. You can use up to 512 threads to send out 

emails simultaneously. Using multiple threads to send out emails can speed up message 

sending. However, if you have a large number of threads, it can also hurt performance while 
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the OS switches between them. The more threads you have the more memory your app 

needs. 

Q. How many connections should I use to get the best 

results? 

To set the "connections", click the Option and Performances button at the Publish tab and 

set the Thread count to the desired value. That should increase delivery speed if you have 

enough bandwidth. To get the best results, use 

 8-32 connections to a 56K dial-up connection  

 33-64 connections to a 128K ISDN connection  

 100+ connections to cable modem, T1, etc.  

17.7 Reports 

Q. Are these reports instant and in real time? 

Yes. 

Q. Is there a way for me to find out who opened my 

email? 

Yes. For Business Edition with tracking service, when you send an HTML format message, you 

can keep track of who open it. 

Q. Can I find out how many people opened my email 

on a specific day after my message had been out? 

Yes. The "Overall Responses and Results by Date" report shows you how many emails were 

opened by the recipients each day, and shows you that daily number as a percentage of the 

total number of emails opened to date. 

Q. Can I track which link users clicked in my 

newsletter? 

Yes, but limits to the Business Edition. You can learn which link generated the most interest 

with the "Overall Responses and Results by Link" report. It lists all the URLs you used in your 

campaign, how many times each link was clicked, and how many clicks each link got as a 
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percentage of total click-throughs. 

Q. Can I view the list of email addresses which failed 

to be sent and why they failed to be sent? 

Yes. Email Marketer offers error code and error message for each failed mail. 

Q. Can I sort the list and messages in report? 

Yes. Click the header of the report table. 

17.8 Purchase and Registration 

Q. Why should I purchase and register Email 

Marketer? 

Email Marketer is not freeware. Registered users can enjoy following benefits, which are not 

available for trial users: 

 Full license to use the software beyond the 30-day evaluation. 

 Registration code to unlock your copy into registered version. 

 200+ additional beautiful email templates and styles. 

 Lifetime FREE version and minor upgrades (e.g. 1.0 -> 2.0 or 2.0 -> 2.1). 

 Discount for edition upgrades (e.g. Personal -> Business). 

 Lifetime FREE technical support by email. 

Q. Can I try Email Marketer before I buy it? 

Yes. You can download the trial version of Email Marketer. However, there are some 

limitations in trial version. 

Q. Which edition of Email Marketer need I buy? 

Email Marketer is available in two different editions to suit every size business including 

Personal Edition and Business Edition. 

You can download the Trial Edition of Email Marketer and try it for Free before purchasing. So, 

you will get a good feel about how the software works and how you can benefit from it. The 

Trial Edition may be converted into a full (registered) edition by entering a valid registration 

key. 
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To see which edition of Email Marketer is best suited to your needs please visit 

http://www.nesox.com which goes through the differences in depth. 

Q. Are there per-message charges or recurring costs? 

No, if you register the Email Marketer software itself, the registration fee is one-off. 

Q. How do I order Email Marketer? 

You will find the Email Marketer Order Form online at: 

http://www.nesox.com/en/email_marketer_purchase.asp 

The Registration code is sent to the email address provided by you right after payment has 

been received. Immediately after the transaction you will receive your registration code by 

email. 

18 Appendix 

18.1 Glossary 

Term Explanation 

ASP Active Server Pages is the script editing environment on the 

server. One can develop dynamic web pages or establish 

powerful network application program with it. ASP includes 

HTML mark, text and command script. 

Click Through When a user selects a hyper text (web page) link. The Click 

refers to the noise a input mouse makes when a button is 

depressed. The through refers to the act of going "through" the 

link. Many web statistics are kept on click-throughs (sometimes 

abbreviated as Click-Thru). Some advertising systems are based 

on paying sites when someone actually Clicks-Thru to a new 

site. 

DHTML Full name is Dynamic HTML. In broad sense, all what can react 

to users operations can be named dynamic HTML; Specifically, it 

means HTML 4.0 defined protocols. 

DNS Service Domain Name System means domain name mapping server, its 

function is to change the domain name into an IP address that 

can be recognized by the network. 

http://www.nesox.com/
http://www.nesox.com/en/email_marketer_purchase.asp
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ESMTP Protocol Enhanced SMTP is an extension of the SMTP protocol that allows 

for new features such as supporting graphics, audio, and video 

files, and text in various foreign languages. Not all mail servers 

implement ESMTP so those features can only be used when both 

the client and the server conform to the protocol. These 

extensions were first described in RFC 1869. Learn more 

GUI User Graphic Interface 

GUID Globally Unique Identifier. Identifier generated according to an 

algorithm that is intended to be unique across all systems. 

HTML Hypertext Markup Language 

Hyper Link Hyper links, abbreviate as links. Method for jumping from one 

site to another on the internet. The hyperlink is often shown in a 

different form from normal text. Should the link be clicked, 

users can begin to jump to other sites. Hypertext has text 

pointed to other texts. Clicking it can show other files. 

IE Microsoft Internet Explorer 

IIS Microsoft Internet Information Server (or Services). 

JavaScript The most popular web script language at present. Used for 

developing dynamic web pages. 

MIME Protocol MIME is the abbreviation for "Multipurpose Internet Mail 

Extensions". As to the complementation of SMTP agreement, 

MIME has been the standard for sending non-text e-mail 

through SMTP protocol. At present, the use of MIME has already 

surmounted the range which just deals with receiving and 

sending e-mail, and has become one of the basic protocols 

transmitting the information of the multimedia on internet. 

ODBC Open Database Connectivity. A common standard of Microsoft 

that allows relational and non-relational database programs - 

like dBase, Oracle, Microsoft Access - to access the information 

independent of its file format. 

OLE DB An open specification that has been developed by Microsoft for 

accessing both relational and nonrelational data. OLE DB 

interfaces can provide much of the same functionality that is 
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provided by database management systems. OLE DB evolved 

from the Open Database Connectivity (ODBC) application 

programming interface. 

RFC Request for Comments. 

ROI Return On Investment. The amount of value received relative to 

the amount of money invested. ROI is a method of measuring 

the success of an ad campaign. 

SMTP Protocol Stands for Simple Mail Transfer Protocol. It is a group of 

protocols for delivering mail from source address to destination 

address. It dictates how the mail would be transmitted. SMTP 

belongs to TCP/IP protocol stacks. Learn more 

TCP/IP Transfer Control Protocol / Internet Protocol. 

VBScript Visual Basic Scripting Edition applies the flexible script to more 

extensive fields, including web application script in IE and web 

server script in Microsoft Internet Information Service. 

WWW Service Abbreviation for World Wide Web. 

XML Extensible Mark-up Language. Like HTML it is a specification for 

formatting web documents and web pages. It supports 

communication between various companies and applications 

and is a simplified version of SGML. Despite the various 

operating system platforms and end devices, data access logic 

and application logic do not have to be changed. 

18.2 SMTP and ESMTP 

Simple Mail Transport Protocol. This is the standard protocol used on the Internet to send mail 

to and between mail servers and clients. This is the protocol Email Marketer uses to send and 

route its mail messages. 

The SMTP Protocol is based on a standard set forth under RFC 821. 

A conversation is established with a SMTP server by connecting to port 25 on the SMTP server. 

After the initial connection, the client (Email Marketer) sends a HELO command followed by a 

domain name. This tells the SMTP server to whom it is talking to. The SMTP server may decide 

to terminate the connection at that point if it does not wish to speak to the specified domain. 

If the HELO command is accepted by the remote server, the SMTP client issues a MAIL-FROM 



Nesox Email Marketer User’s Manual 

 

Copyright © 2010, Nesox Solutions. 144 

command followed by the "from address" of the e-mail being sent. Once again, the SMTP 

server may decide to terminate the connection if it does not wish to receive mail from the 

specified sender. 

NOTE: Some SMTP servers may do a reverse lookup on the domain name specified 

for the HELO or FROM command. If the IP address of the SMTP client is not 

registered to that domain, the client may be considered an imposter, and the 

connection will be dropped. 

After the from address is accepted, the SMTP client issues a RCPT-TO command followed by 

the address of the intended recipient. At this point the SMTP server has the opportunity to 

reject mail being sent to the specified address. For example, some SMTP servers will only 

accept mail for local users. 

The SMTP client may issue multiple RCPT-TO commands to the server, thus adding more 

recipients to the message. When the SMTP client is through adding the recipients to the 

message, it issues the DATA command to the server. 

If the DATA command is accepted, the SMTP client then proceeds to send the message 

headers, followed by a blank line, followed by the message body and file attachment data. 

When the SMTP client is through sending the message data, it sends a carriage return, 

followed by a period, followed by a carriage return, to indicate the end of the message. 

At this point the SMTP server acknowledges the receipt of the message data. The SMTP client 

may then proceed to send another message, or can send the QUIT command to terminate the 

conversation. 

Email Marketer goes a little further that SMTP where supported by using Extended commands 

such as pipelining and authentication. 

Email Marketer complies with the following protocols relating to email. 

 821 The SMTP protocol 

 822 Standard for the format of ARPA Internet text messages 

 974 Mail routing and the domain system 

 1854 SMTP Service Extension for Command Pipelining 

 1869 SMTP Service Extensions (ESMTP) (Obsoletes RFC1651) 

 1891 SMTP Service Extension for Delivery Status Notifications 

 1939 Post Office Protocol - Version 3. (Obsoletes RFC1725) 

 2045 Multipurpose Internet Mail Extensions (MIME) Part One: Format of Internet 

Message Bodies. (Obsoletes RFC1521 RFC1522 RFC1590) 

 2046 Multipurpose Internet Mail Extensions (MIME) Part Two: Media Types. (Obsoletes 

RFC1521 RFC1522 RFC1590) 
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 2047 MIME (Multipurpose Internet Mail Extensions) Part Three: Message Header 

Extensions for Non-ASCII Text. (Obsoletes RFC1521 RFC1522 RFC1590) 

 2554 SMTP Service Extension for Authentication 

18.3 Error Codes 

Code Description 

Internal Errors 

100 Unable to create message raw file. 

101 Message raw file was not found. 

102 Invalid email address. 

103 Preserved 

104 Preserved 

105 Email address in exclusion list. 

106 Unable to find mail exchange server for a specified email 

address. 

107 Mail exchange server for a specified email address was not 

found. 

108 Socket disconnected. 

External Errors 
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19 Order and Registration 

19.1 Ordering Email Marketer 

Why Order? 

Join the family of registered Nesox customers by registering your copy of Email Marketer. 

Registration can be completed in just a few seconds using the Internet. 

Important: Ordering online is the easiest and fastest way to get the product. Your 

order is secure because all the information is safely encrypted. 

Registered users can enjoy following benefits and advantages, which are not available for trial 

users. 

 Full license to use the software beyond the 30-day evaluation. 

 Registration code to unlock your copy into registered version. 

 200+ additional beautiful email templates and styles. 

 Lifetime FREE version and minor upgrades (e.g. 1.0 -> 2.0 or 2.0 -> 2.1). 

 Discount for edition upgrades (e.g. Personal -> Business). 

 Lifetime FREE technical support by email. 

 Trial version limitation removed. 

 You will support Email Marketer development to make it even better. 

To Order Online Using Internet 

The registration fee is US $99.95 for Personal Edition and $199.95 for Business Edition; The 

Registration key and other necessary information will be sent to the email address provided 

within one business day after the purchase. It's fast! 

You will find the Email Marketer Order Form online at: 

http://www.nesox.com/en/email_marketer_purchase.asp. 

19.2 License Agreement 

END-USER LICENSE AGREEMENT FOR EMAIL MARKETER 

 

BEFORE YOU USE THE SOFTWARE, PLEASE READ THIS AGREEMENT CAREFULLY. 

 

This end-user license agreement ("EULA") is a legal agreement between you (either an 

http://www.nesox.com/en/email_marketer_purchase.asp
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individual or a single entity) and Nesox Solutions Inc. For Email Marketer, including computer 

software, electronic documentation and printed materials ("SOFTWARE"). By Downloading, 

installing, copying, or otherwise using the SOFTWARE, you agree to be bound by the terms of 

this agreement. If you do not agree to the terms of this EULA, promptly destroy all copies of 

the SOFTWARE, including any updates, in your possession or return them to Nesox Solutions. 

 

1. GENERAL TERMS OF USE 

Your use of the Software, Service, and Site, including any content and software contained 

therein, signifies your understanding and agreement that such use is entirely at your own risk. 

You agree to use the Software, Service and Site solely for your personal use as an online 

electronic mail management tool. Nesox Solutions does not guarantee reliability, accuracy, or 

completeness of the Software, Service or Site. 

 

The SOFTWARE is protected by copyright laws and international copyright treaties, as well as 

other intellectual property laws and treaties. The SOFTWARE is licensed, not sold. You may 

not rent, lease, or lend The SOFTWARE. You may permanently transfer all your rights under 

this End-User License Agreement, provided you retain no copies, you transfer all of The 

SOFTWARE and this End-User License Agreement, and the recipient agrees to the terms of 

this End-User License Agreement. 

 

2. CHANGES IN TERMS AND CONDITIONS OF USE 

Email Marketer is not free software. You may use this software for evaluation purposes free of 

charge for a period of 30 days. If you use this software after the 30 day evaluation period, you 

must pay registration fee. 

 

Nesox Solutions may change these Terms and Conditions from time to time and at any time, 

with or without a release of a new version of the Software, and without actual notice to you. 

All such changes to this Agreement will appear on the Site. Email Marketer may provide 

additional notice of such changes by providing a link from the Service to the Site. You agree 

that your continuing to use the Software, Service and/or Site for a period of thirty (30) days 

after such notice has been posted on the Site for the first time shall constitute your consent 

to the new or revised set of Terms and Conditions.  

 

3. GRANT OF LICENSE 

This program version may be installed on a maximum of two computers, so long as it is ONLY 

running on one system at any time: i.e. one installation at home and one installation at the 

office and used only by the licensee. The simultaneous use of this SOFTWARE by multiple 

personnel requires additional licenses. Use of this SOFTWARE over an internal network 

requires separate license for each user. The licensee shall not use, copy, rent, lease, sell, 

modify, decompile, disassemble, reverse engineer, or transfer the licensed SOFTWARE except 

as provided in this agreement. Any such unauthorized use shall result in immediate 

termination of this license. 

 

All licenses will be issued in the name of the institution, company or school. Each additional 
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license also allows a single user to use The SOFTWARE at home. 

 

4. LIABILITY 

We try to keep our SOFTWARE as bug free as possible. However, it is a general rule, Murphy's, 

that no software is ever error free, and the number of errors increases with the complexity of 

the program. We cannot guarantee that this SOFTWARE will run in every environment, on any 

Windows compatible machine, or together with any other application, without producing 

errors. Any liability for damage of any sort is hereby denied. In no event shall Nesox Solutions 

Inc. or its suppliers be liable for any special, incidental, indirect, or consequential damages 

whatsoever (including, without limitation, damages for loss of business profits, business 

interruption, loss of business information, or any other pecuniary loss) arising out of the use 

of or inability to use The SOFTWARE. In any case, the liability is limited to the registration fee. 

Please evaluate this SOFTWARE with not critical data. Should you detect errors before 

registration, the user accepts The SOFTWARE errors after registration. Any description of 

SOFTWARE errors will be accepted, but we cannot guarantee that the errors can be corrected. 

 

5. DISCLAIMER OF WARRANTIES 

The Author of this Software expressly disclaims any warranty for the SOFTWARE. The 

SOFTWARE and any related documentation is provided "as is" without warranty of any kind, 

either express or implied, including, without limitation, the implied warranties or 

merchantability, fitness for a particular purpose, or noninfringement. The entire risk arising 

out of use or performance of the SOFTWARE remains with you. 

 

6. AUTHORIZED CLIENTS 

You are responsible and liable for any activity by any person who uses the Service through 

your user name and password. You are responsible for maintaining the confidentiality of your 

password and for any liability resulting from disclosure of your password. You agree to 

immediately notify Nesox of any unauthorized use of the Service or any other breach of 

security known or suspected by you.  

 

7. APPLICABLE LAWS / JURISDICTION 

You agree to abide by U.S. and other applicable export control laws and not to transfer, by 

electronic transmission or otherwise, any content or software subject to restrictions under 

such laws to a national or other destination prohibited under such laws, without first obtaining, 

and then complying with, any requisite government authorization. You further agree not to 

upload to or through the Service any data or software that cannot be exported out of the 

United States without prior written government authorization, including but not limited to, 

certain types of encryption software. The above assurance and commitment shall survive 

termination of this agreement. 

 

You agree that the laws of the State of New York, excluding its conflicts-of-law rules, shall 

govern this Agreement. Please note that your use of the Software as well as the Service and 

Site may be subject to other local, state, national, and international laws. You expressly agree 

that exclusive jurisdiction for any claim or dispute with Nesox or relating in any way to your 
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use of the Software, Service or Site resides in the courts of the State of New York, and you 

further agree and expressly consent to the exercise of personal jurisdiction in the courts of 

the State of New York, in connection with any such dispute and including any claim involving 

Nesox Solutions or its affiliates, subsidiaries, employees, contractors, officers, directors, 

telecommunication providers and content providers. 

 

8. DISTRIBUTION 

You may copy the evaluation version of this software and documentation as you wish, and 

give exact copies of the original evaluation version to anyone, and distribute the evaluation 

version of the software and documentation in its unmodified form via electronic means. But 

you should not charge or requesting donations for any such copies however made and from 

distributing the software and/or documentation with other products without the author's 

written permission. 

 

9. DO NOT SEND UNSOLICITED EMAIL 

Email Marketer is not licensed for sending bulk unsolicited commercial email. Be aware that 

you are solely responsible for the messages you send. In many cases sending unsolicited 

email (AKA Spam) is in violation of the law, and you will be solely accountable and liable for 

damages and violations. 

 

We reserve the right to refuse technical support and/or other services if you: 

 

1. send unsolicited email, individuals not expecting to receive it; or 

2. you hijack a mail server relay; or 

3. distribute illegal information or materials; or 

4. forge header information; or 

5. put false of misleading information in the subject; or 

6. fail to provide a means for unsubscribing from your lists or groups 

 

Additionally, you must guarantee that anyone receiving your email has a mechanism whereby 

they may conveniently request not to participate in future mailings. You may use Marketer's 

exclude list feature, along with Email Marketer Monitor, to manage your removal list if you 

wish. Email Marketer is committed to fighting SPAM, while providing a necessary business 

communication tool. 

20 Technical Support 
We want to make sure you are satisfied with our software, and we will do our best to get back 

to you as quickly as possible. 

We pride ourselves on our highly responsive support. If you email support, you will get an 

email response within 1 business day. If you run into a minor feature issue which originates 

from the software we will make every attempt to fix it in an update within 15 days. 
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Everyone needs help at some time. If you have a question about Email Marketer, please read 

the help text related to the option you are using. You may also find it useful to browse 

Frequently Asked Questions (FAQ) and Troubleshooting to see if an answer is already 

provided there. 

If you want to report an error you experienced, please include your OS information, version 

of Email Marketer and the error screenshot in your email. 

For the latest information about products or services provided by Nesox Solutions, visit our 

home page: http://www.nesox.com 

For...   Click here 

Free support  support@nesox.com 

Feature requests feature@nesox.com 

Bug reports  bug@nesox.com 

Buy now   http://www.nesox.com/en/email_marketer_purchase.asp 

For more details, please visit http://www.nesox.com/en/about_support.asp 

http://www.nesox.com/
mailto:support@nesox.com
mailto:feature@nesox.com
mailto:bug@nesox.com
http://www.nesox.com/en/email_marketer_purchase.asp
http://www.nesox.com/en/about_support.asp
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